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Введение 

 

Уже в течение нескольких последних десятилетий геоинформационные 

системы (ГИС) являются главным средством получения новых знаний в облас-

ти наук о Земле. ГИС представляют собой интегрированную совокупность про-

граммного и аппаратного обеспечения, а также алгоритмических процедур для 

введения, обработки, хранения, анализа и отображения пространственно-

координированных данных. Сфера использования ГИС все время расширяется. 

В настоящее время она касается самых разных областей деятельности, где нуж-

но выполнять анализ пространственной составляющей взаимодействия приро-

ды, хозяйства и населения: от научных исследований, до оптимизации бизнес-

процессов. 

Географу, как никому другому, важен инструментарий ГИС в решении 

задач своей предметной области. Несмотря на то, что ГИС задействованы во 

многих отраслях знания, пространственный аспект исследования, составляю-

щий основу ГИС, именно в географии играет ключевую роль. Именно геоин-

формационные системы придают современной географии прагматическое со-

держание и обеспечивают место для нашей предметной области на современ-

ном рынке бизнес-услуг.  

Геоинформационные системы могут помочь решить географу, по крайней 

мере, две противоположные по своей сути проблемы: 

1) Если исследователь испытывает недостаток в данных, но при этом не-

обходимо делать определенные выводы и принимать решения; 

2) При избытке пространственных данных, когда возникает необходи-

мость их сортировки, упрощения, фильтрации и т.п. 

Одним из наиболее популярных средств автоматизированного решения 

подобных задач есть ГИС-платформа ArcGIS. В четырех практикумах данного 

пособия рассматриваются главные особенности работы с этой ГИС-

платформой. 

В первом практикуме рассматриваются общие вопросы работы с ГИС: 

работа с проектами, добавление / удаление слоев, создание новых слоев, управ-

ление хранением ГИС-данных на компьютере, просмотр геоинформационных 

слоев, навигация в окне карты и другие. 

Второй практикум посвящен атрибутивным таблицам и работе с ними: 

просмотру и настройке отображения данных в таблицах, добавлению новых 

полей в таблицу, сортировке записей, расчету значений в полях. 

В третьем практикуме рассматриваются выборки и запросы, как инст-

румент пространственного анализа в ГИС: общие принципы формирования за-

просов, выборки по атрибуту и выборки по пространственному положению. 
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Четвертый практикум посвящен созданию тематических карт и работе с 

компоновками. Рассматриваются различные способы визуализации атрибутив-

ных данных.  

 

Практикум 1. Начало работы в ArcGIS 9.3.1 

 

Цель: ознакомиться с интерфейсом и основными функциональными воз-

можностями программ ArcMap и ArcCatalog. 

Задачи:1. Исследовать работу программы ArcCatalog. 

2. Создать новый геоинформационный слой в программе ArcMap. 

3. Исследовать способы навигации в окне карты. 

4. Создать рабочий проект *.mxd на основе открытых слоев и настроек их 

визуализации. 

Исходные данные: shape-файлы STATES, CITIES, COUNTIES из каталога 

…\practicum_data\ArcGIS_data\usa 

 

Работа пользователя в программном интерфейсе 

 

ArcCatalog и ArcMap. Добавление слоев на карту 

1. Запустите программу ArcCatalog (Пуск → Bсе программы → ESRI → 

ArcCatalog). 

ArcCatalog содержит дерево каталога и закладки Contents, Preview, 

Metadata (Содержание, Просмотр, Метаданные). Есть также панели инстру-

ментов (рис. 1.1): Metadata, Location, Standard, Geography (Метаданные, Ме-

стоположение, Стандартная, География). 

 

 
Рис. 1.1. Панели инструментов ArcCatalog 



6 
 

2. Нажмите на кнопку  Connect To Folder  (Подключение к папке) на 

панели инструментов Standard. 

3. Перейдите в директорию…\practicum_data\ArcGIS_data, а в ней  вы-

делите учебную папку usa с данными по США. Нажмите кнопку OK для добав-

ления в дерево каталога нового подключения  к папке usa (рис. 1.2). 

4. Выделите подключение к папке usa, которое вы только что добавили –  

на закладке Contents будет отображен перечень всех слоев, входящих в папку 

usa. 

 
Рис. 1.2. Новое подключение в дереве каталога ArcCatalog 

 

5. Нажав на «+» в дереве каталога возле нового подключения, раскройте 

содержимое папки usa. Выделите какой-нибудь из слоев в папке usa, например, 

слой COUNTIES (округа), а затем перейдите на закладку Preview – будет ото-

бражена карта округов (рис. 1.3), кнопки панели инструментов Geography ста-

нут доступными. Используя эти кнопки, вы можете выполнять навигацию на 

появившейся карте. 

 

 
Рис. 1.3. Отображение слоя округов (выделен в дереве каталога) на вкладке Preview про-

граммы ArcCatalog 

 

6. В выпадающем списке Preview (внизу, под картой) смените способ 

представления данных с Geography на Table – на вкладке Preview будет ото-
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бражена таблица атрибутов слоя. 

7. Перейдите на вкладку Metadata – будут показаны метаданные слоя, па-

нель инструментов Metadata станет активной. 

Теперь запустите программу ArcMap, кликнув на кнопке Launch ArcMap 

(Запустить ArcMap) на панели инструментов Standard. Закройте стартовое ок-

но программы ArcMap (содержит опции открытия последних использованных 

ГИС-проектов и прочих данных), если такое появится сразу после запуска при-

ложения.  

Программа ArcMap предназначена для создания, просмотра, редактиро-

вания и компоновки карт. Окно ArcMap включает: таблицу содержания, кар-

ту, панели инструментов. Карта может быть представлена в виде данных и в 

виде компоновки. Таблица содержания (Table Of Contents) отображает пере-

чень добавленных в ArcMap слоев и таблиц. Если Таблица содержания отсут-

ствует в окне ArcMap, добавьте ее, выполнив команду меню Windows → Table 

of contents (Окно → Таблица содержания).  

Добавьте слои STATES (штаты) и CITIES (города) в ArcMap: 

1. Нажмите кнопку  Add Data (Добавить данные) на панели инстру-

ментов Standard программы ArcMap.  

2. В появившемся окне поиска слоев перейдите в учебную директорию 

usa и, удерживая нажатой клавишу Ctrl, выделите слои CITIES и STATES. На-

жмите кнопку Add, чтобы добавить выбранные слои в программу ArcMap. 

Выполнить добавление вы также можете, перетаскивая иконку слоя из 

дерева каталога ArcCatalog на карту в окне ArcMap.  

Программу ArcCatalog теперь можно закрыть. Далее, в рамках данного 

практикума, мы работаем только с программой ArcMap. 

 

Видимость слоев 

Видимость объектов слоя в окне карты может быть ограничена ввиду 

следующих обстоятельств:  

 Режим видимости слоя отключен; 

 Слой перекрыт другими слоями; 

 Видимость всех или части объектов слоя отключена согласно Опреде-

ляющему запросу; 

 Применены настройки прозрачности слоя; 

 Применены специфические настройки стилей отображения ГИС-

объектов. 

Указанные особенности отображения слоев будут рассмотрены в после-

дующих 11 шагах выполнения данного практикума. 
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По умолчанию, слои в ArcMap добавляются в следующем порядке: в са-

мом низу растровые поверхности, выше  полигональные объекты, затем  ли-

нии, а на самом верху  точки. В этом случае слои в наименьшей степени пере-

крывают друг друга. Эту последовательность можно менять вручную. 

1. Снимите флажок рядом со слоем CITIES, чтобы отключить его види-

мость. 

2. Выполнив команду Add Data, добавьте на карту слой COUNTIES. При 

добавлении в окно карты слой округов перекрывает слой штатов. 

3. Выберите слой COUNTIES и, удерживая нажатой левую кнопку мыши, 

перетащите слой на уровень ниже (под слой штатов) – слой штатов будет ви-

ден. 

4. В таблице содержания кликните правой кнопкой мыши на слое штатов 

и выберите Properties (Свойства). 

5. В окне свойств слоя перейдите на вкладку Display (Отображение). 

6. В поле Transparent (Прозрачность) введите 25 % и нажмите OK для 

применения указанной настройки. В результате слой штатов стал на четверть 

прозрачным. Теперь вы можете отчетливо видеть полигональные объекты слоя 

COUNTIES, расположенные под ним. 

7. В таблице содержания кликните на прямоугольнике (справа от назва-

ния слоя STATES), иллюстрирующем стиль символа  для слоя штатов. 

8. В появившемся окне Symbol Selector (Выбор символа) установите стиль 

Hollow (англ. – пустой, полый) или раскройте палитру цветов для заливки Fill 

Color (Цвет заливки), чтобы выбрать в ней стиль No Color (Нет цвета) (рис. 

1.4). Теперь вы можете полностью видеть слой COUNTIES, так как выбранный 

для слоя штатов стиль не содержит заливки. 

 

 
Рис. 1.4. Стиль Hollow и палитра цветов для выбора способа заливки  
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9. Рассмотрим особенности работы определяющего запроса. Включите 

видимость для слоя CITIES и откройте для него окно свойств слоя. 

10. Перейдите на вкладку Definition Query (Определяющий запрос) и на-

жмите кнопку Query Builder (Построитель запросов). 

11. В появившемся окне Query Builder введите следующий запрос: 

"CAPITAL" = 'Y' OR "POP2010" > 1000000 (рис. 1.5). Два раза нажмите ОК: в 

окнах Query Builder и Definition Query.  

 

 
Рис. 1.5. Определяющий запрос для слоя CITIES 

 

В  результате применения определяющего запроса видимыми будут толь-

ко те объекты слоя, которые удовлетворяют критерию запроса: либо (оператор 

OR) города со столичным статусом (Capital=Y, где Y – “Yes”), либо те, которые 

имеют население более 1 миллиона человек (POP2010> 1000000, где POP – со-

кращение от Population – численность населения).  

К использованию определяющих запросов мы вернемся немного позднее, 

при рассмотрении разработки карт в практикуме 4.  

 

Понятие о слое *.lyr 

1. Кликните один раз на значке города в таблице содержания, чтобы вы-

звать окно Symbol Selector. 

2. Установите стиль символа Sircle 1, уменьшив в контроле Size (правая 

часть окна Symbol Selector, фрейм Options) его размер с 18 на 8.  

3. В таблице содержания кликните правой кнопкой мыши на имени слоя 

CITIES. В появившемся контекстном меню выберите Save As Layer File… 

4. В появившемся окне Save Layer перейдите в учебную директорию и со-

храните слой под именем СITIES_1 – слой будет сохранен в расширении  .*lyr. 

5. Удалите слой СITIES из таблицы содержания. Для этого нажмите пра-

вой кнопкой мыши на слое СITIES и в контекстном меню выберите команду 

Remove. 

6. Добавьте в окно карты заново слои СITIES_1.lyr и СITIES.shp. Сравните 

результаты: layer-файл добавился с теми же параметрами визуализации, как вы 

и экспортировали; shape-файл добавлен со случайным стилем и показывает все 

объекты слоя, в отличие от файла *.lyr, где определяющий запрос по-прежнему 

активен.  
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7. Удалите слой СITIES.shp из окна карты. Покажите предварительный 

результат работы преподавателю. 

 

Сохранение и открытие *.mxd –документов 

1. Выполните команду меню File → Save (Файл → Сохранить). 

2. В появившемся окне Сохранить как установите путь для сохранения в 

вашу директорию и назовите файл practicum_ag_1. Нажмите ОК. 

3. Выполните команду меню File → New (Файл → Новый). В результате 

вы получите новый безымянный пустой документ. 

4. Выполните команду меню File → Open (Файл → Открыть). 

5. Перейдите в учебную директорию, выберите ранее сохраненный файл 

practicum_ag_1.mxd и нажмите Open. 

У вас откроется сохраненный рабочий проект, со всеми использовавши-

мися слоями и параметрами их визуализации (порядок слоев на карте, прозрач-

ность, определяющий запрос и другие), которые были настроены для них перед 

сохранением в *.mxd-документе. 

 

Навигация по карте 

Навигация по карте выполняется при помощи изменений масштаба и пе-

ремещений картографического изображения во фрейме данных. Также можно 

использовать функциональность по «подгонке» под рамку карты одного из сло-

ев, его выборки, или всех слоев сразу (так называемый «полный экстент»). По-

ложение объектов во фрейме данных определяется следующими параметрами, 

которые взаимно влияют друг на друга: 

1. X/Y- координаты ограничивающих рамок для текущего экстента карты; 

2. Координаты центра карты для текущего экстента; 

3. Масштаб. 

Самый простой способ изменения масштаба карты – покрутить колеси-

ко мыши над активной картой. Картографическое изображение будет то уда-

ляться, то приближаться. Можно также использовать инструменты  Zoom 

In и Zoom Out: как кликая ими на карте, так и рисуя прямоугольники на том 

участке слоя, который нужно приблизить (укрупнить масштаб или 

«зазумиться») или отдалить (уменьшить масштаб). Показать все ГИС-объекты 

всех слоев в пределах рамки карты можно нажав кнопку   Full Extent 

(Полный экстент) – картографическое изображение будет представлено таким 

образом, что объекты с минимальными и максимальными значениями будут 

расположены по краям карты, т.е. изображение будет «подогнано под рамку».  
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Для исследования работы указанных инструментов вы можете выполнить  

следующие действия: 

1. Нажмите кнопку Full Extent на панели Tools – все объекты всех слоев 

будут отображены в пределах фрейма данных. 

2. Выберите инструмент Zoom In и кликните им пару раз по карте для 

увеличения масштаба. Для уменьшения масштаба выберите инструмент Zoom 

Out и кликните им тоже пару раз по карте. Обратите внимание, что 

местоположение, где вы кликаете этими инструментами, располагается после 

этого строго по центру фрейма данных. 

3.  Нажмите кнопку Full Extent для показа объектов всех слоев, а затем 

выберите инструмент Zoom In  и нарисуйте с его помощью прямоугольник 

сверху над каким-нибудь из штатов, (в примере на рис. 1.6  над штатом Мэн). 

 

 
Рис.1.6. Работа инструмента Zoom In 

 

4. На панели Tools нажмите раз на кнопку  Go Back To Previous Extent 

– масштаб и положение картографического изображения относительно фрейма 

данных вернутся в первоначальное состояние (в нашем случае – в полный 

экстент), как это было до укрупнения масштаба. 

5. Нажмите раз на кнопку  Go To Next Extent – текущее изображение 

во фрейме данных будет подогнано под прямоугольник, который Вы рисовали 

ранее инструментом Zoom In. Инструменты Go Back To Previous / Next Extent 

позволяют возвращаться от текущего положения карты во фрейме назад к 

предыдущему и наоборот. 

6. Нажмите один-два раза на кнопку  Fixed Zoom In на панели Tools – 
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картографическое изображение будет «приближаться» так, будто бы Вы 

кликнули инструментом Zoom In строго по центру фрейма данных.  Работа 

инструмента  Fixed Zoom Out противоположна инструменту Fixed Zoom In. 

7. Выберите инструмент  Pan и, удерживая нажатой левую клавишу 

мыши, переместите изображение в пределах фрейма данных. 

Указанные кнопки доступны также из меню View и из контекстного меню 

для фрейма данных.  

Помимо отображения полного экстента ArcMap позволяет «подогнать» 

под рамку карты определенный слой.   

1. При помощи инструмента Add Theme добавьте из учебной директории 

в окно карты слой LAKES (озера). 

2. Нажмите левой кнопкой мыши на прямоугольнике стиля озер в таблице 

содержания и в появившемся окне Symbol Selector измените текущий стиль на 

синюю заливку. 

3. Нажмите правой кнопкой мыши на слое LAKES в таблице содержания и 

в появившемся контекстном меню выберите Zoom To Layer (Приблизить к 

слою) – крайние северные, южные, восточные и западные озера, которые 

представлены в данном слое, будут расположены по краям, возле рамки карты. 

Функциональность ArcMap также позволяет настраивать эффект 

масштабирования для объектов слоя. Настроим эффект для слоя городов 

таким образом, чтобы в масштабе мельче 1 : 70 000 000 (в 1 см 700 км) города 

не отображались на карте. 

1. Кликните правой кнопкой мыши на слое городов в таблице содержания 

и в появившемся контекстном меню выберите Properties (Свойства). 

2. В окне свойств слоя перейдите на вкладку General. 

3. В групбоксе Scale Range включите опцию Don’t show layer when 

zoomed. 

4. В поле Out beyond установите значение 1 : 70 000 000, а в поле In 

beyond – None (рис. 1.7). Нажмите ОК в окне свойств слоя. 

 

 
Рис. 1.7. Параметры масштабирования в окне свойств слоя (вкладка General) 

 

5. На панели инструментов Standard в поле для масштаба впечатайте лю-

бое значение масштаба мельче 1 : 70 000 000 (например, 1: 75 000 000) и на-



13 
 

жмите Enter – к изображению применится заданный масштаб, символы городов 

отображаться на карте не будут. 

Граничное значение масштаба можно установить также через контекст-

ное меню слоя, для которого настраивается масштабный эффект. Используя 

этот способ, смените граничное значение масштаба с 1 : 70 000 000 на 1 : 

80 000 000. 

1. На панели инструментов Standard в поле для масштаба впечатайте зна-

чение масштаба 1 : 80 000 000 и нажмите Enter. 

2. Нажмите правой кнопкой мыши на слое городов в таблице содержания. 

В появившемся контекстном меню выполните команду Visible Scale Range → 

Set Minimum Scale – текущий масштаб карты 1 : 80 000 000 запишется как гра-

ничное значение масштаба для отображения объектов слоя городов. Вы можете 

проверить это в окне свойств слоя или же установив в поле для масштаба на 

панели инструментов Standard промежуточное значение  1: 75 000 000. Если 

раньше в этом масштабе города не отображались, то теперь они видны. 

Удобными для навигации по карте есть элементы функциональности 

Magnifier (Увеличитель), Viewer (Просмотр) и Overview (Обзор), которые дос-

тупны пользователю из меню Window (Окно). 

Magnifier (рис. 1.8) и Viewer позволяют просматривать фрагмент карто-

графического изображения в отдельном окне в более крупном или мелком 

масштабе.  

 
Рис. 1.8. Работа функциональности Magnifier 

 

Magnifier содержит выпадающий список для установки процента укруп-

нения (если значение больше 100%) или уменьшения картографического изо-

бражения в своем окне. Viewer имеет схожие особенности работы, с той лишь 

разницей, что в выпадающем списке устанавливают масштаб. Кроме этого, 

Viewer частично дублирует функциональность основного фрейма карты: со-

держит инструменты Zoom, Pan, Full Extent и другие, которыми можно напря-

мую воспользоваться в окне Viewer. 

Overview – окно, в котором отображены все видимые слои карты в режи-
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ме Full Extent, а красной рамкой показаны границы карты в текущем масштабе 

и расположении во фрейме данных (рис. 1.9). 

 

 
Рис. 1.9. Работа инструмента Overview 

 

Для завершения исследований особенностей навигации по карте рассмот-

рим функциональность по созданию закладок в программе. Создадим про-

странственную закладку для штата Нью-Джерси. После перехода по закладке 

контур штата будет «подогнан» под рамки карты так, чтобы он был виден пол-

ностью в максимально крупном масштабе. 

Для начала найдем штат на карте. 

1. Выберите инструмент  Find на панели Tools или в меню Edit. В ре-

зультате откроется окно Find. 

2. В поле Find наберите «New Jersey». 

3. Уже на этом этапе вы можете нажать кнопку Find. Программа будет 

искать запись «New Jersey» в полях таблиц всех открытых слоев. Однако поиск 

можно специфицировать еще детальнее: установить таблицу (в нашем случае – 

STATES) и поле (STATE_NAME) для поиска записи «New Jersey». Другие табли-

цы и поля при поиске будут проигнорированы. 

4. Теперь можно нажать Find – в окне Find появится список объектов слоя 

STATES, которые содержат по полю STATE_NAME запись «New Jersey». Есте-

ственно, что это будет один объект (рис. 1.10). 



15 
 

 
Рис. 1.10. Поиск объекта по имени в диалоге Find 

 

5. Кликните правой кнопкой мыши на строке «New Jersey» в списке 

найденных объектов. Выберите в контекстном меню Zoom To – экстент будет 

подогнан под границы штата Нью-Джерси. 

6. Кликните правой кнопкой мыши на строке «New Jersey» в списке 

найденных объектов, а затем выберите в контекстном меню Create Bookmark 

(Создать закладку). 

7. Закройте окно Find и установите режим Full Extent для показа всех 

слоев. 

8. Перейдите в меню Bookmarks (Закладки). Меню должно содержать 

закладку «New Jersey». Выберите эту закладку – экстент вновь будет подогнан 

под границы штата Нью-Джерси. 

Как Вы заметили, создать закладку можно также выполнив команду 

Bookmarks → Create. При этом закладка будет создана для текущего экстента 

карты. Менеджер закладок (меню Bookmarks → Manage) позволяет управлять 

закладками, например, удалять закладки. 
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Измерение расстояний по карте 

Измерение расстояний возможно посредством инструмента Measure на 

панели Tools.  

1. Установите экстент по закладке «New Jersey». 

2. Выберите инструмент Measure. 

3. В появившемся окне Measure  (рис. 1.11) выберите инструмент Measure 

Line и измерьте с его помощью расстояние между городами Dover и 

Philadelphia – в окне Measure будут показаны общее расстояние «пройденное» 

инструментом по карте и длина текущего сегмента. Для точного наведения на 

пунсоны городов Вы можете воспользоваться функциональностью  Snap to 

Feature (on/ off). 

 
Рис. 1.11. Измерение расстояний при помощи инструмента Measure 

 

Функциональность также позволяет  измерять площади (кнопка Measure 

An Area), получать информацию о координатах, площади и периметре конкрет-

ного векторного объекта (кнопка Measure A Feature). В настройках инструмен-

та можно выбрать требуемые единицы измерения расстояний и площадей. 

 

Выбор объектов в окне карты. 

Выбрать один или больше объектов на карте можно простым кликом на 

объекте(ах) инструментом   Select Features (Выбрать объекты). 

1. Выберите инструмент Select Features и кликните им один раз на любом 

из объектов слоя городов. 

2. Нажмите правой кнопкой мыши на карте и в появившемся контекстном 

меню выберите Zoom to Selected Features – экстент будет установлен так, чтобы 

все выбранные объекты были видны во фрейме данных в самом крупном мас-

штабе.  

Обратите внимание, что выбраны объекты сразу трех слоев: как городов, 
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так и округов и штатов, в пределах которых вы кликнули инструментом Select 

Features. Кроме того, одним щелчком одновременно могут быть выбраны даже 

несколько объектов одного слоя. На рисунке 1.12 показан результат подобного 

выбора: в режиме Full Extent был выполнен щелчок по пунсону города (в на-

шем случае это город Augusta – столица штата Мэн), однако в выборку попали 

полигоны слоев STATES и COUNTIES, на которые вы тоже кликнули. Обратите 

внимание, что выбрано несколько соседних объектов слоя COUNTIES. 

 

 
Рис. 1.12. Результат выбора ГИС-объектов слоя штатов, городов и округов  

по щелчку инструментом Select Features 

 

Изменим настройки для выбора объектов слоев в окне карты. 

3. Выполните команду меню Selection → Set Selectable Layers (Устано-

вить выбираемые слои). 

4. В окне Set Selectable Layers отключите все чекбоксы кроме как для слоя 

STATES. Нажмите ОК. После этого объекты слоев CITIES, COUNTIES, LAKES 

не будут выбираться инструментом Select Features. 

5. Чтобы выборка была более точной, то есть в области нажатия 

инструментом Select Features выбиралось меньшее количество соседних 

объектов, выполните команду меню Selection → Options. В появившемся окне  

Selection Options, в поле Selection tolerance установите значение меньше теку-

щего, например, 1. Наоборот, чем больше значение в этом поле – тем больше 

соседних объектов попадет в выборку. 

6. В окне опций смените цвет для объектов выборки, нажав 

соответствующую кнопку во фрейме Selection Color. Установите цвет по 

собственному усмотрению. Указанный цвет будет применятся для всех слоев, 

которые не имеют собственного стиля отображения выборки на карте.  

7. Нажмите ОК в окне Selection Options.  
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8. Для слоя штатов установим свой собственный стиль показа выборки на 

карте. Для этого откройте окно свойств слоя STATES, перейдите на вкладку 

Selection, включите радио-баттон with this symbol (рис. 1.13) – кнопка для 

установки стиля отображения выборки на карте станет доступной. Нажав ее, вы 

можете установить требуемый стиль показа выбираемых объектов. Установите 

стиль по собственному усмотрению. 

 

 
Рис. 1.13. Окно свойств слоя, вкладка Selection (фрагмент):  

функциональность для установки стиля отображения выборки на карте  

 

9. Выполните команду меню Selection → Clear Selected Features – выбор-

ка снимется со всех объектов в окне карты.  

Снять выборку можно также выполнив следующие действия:  

 нажав на соответствующую кнопку  Clear Selected Features на пане-

ли Tools; 

 нажав на соответствующую кнопку  Clear Selected Features в контекст-

ном меню фрейма данных; 

 кликнув инструментом Select Features на свободном от ГИС-объектов 

пространстве карты. 

Чтобы снять выборку только с объектов конкретного слоя, необходимо 

выполнить команду Selection → Clear Selected Features из контекстного меню 

слоя в таблице содержания. 

10. Установите для карты режим Full Extent и кликните опять на тот же 

самый объект слоя городов, что и раньше – в соответствии с предустановлен-

ными ранее параметрами будет выбран только объект слоя штатов. 

Выбирать объекты на карте можно также «рисуя» инструментом Select 

Features прямоугольники. Существует несколько опций выбора, которые могут 

быть заданы в групбоксе Interactive selection, в окне диалога Selection Options: 

1) Выбор объектов, частично или полностью расположенных в пределах 
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нарисованного прямоугольника (опция Select features partially or completely 

within the box or graphic(s)); 

2) Выбор объектов, которые полностью расположены в пределах нарисо-

ванного прямоугольника (опция Select features completely within the box or 

graphic(s)); 

3) Выбор объектов, в пределах которых полностью расположен нарисо-

ванный полигон (опция Select features that the box or graphic(s) are completely 

within). 

Опция 3 не имеет отношения к точкам и полилиниям, которые не харак-

теризуются площадью. Опции 1 и 2 одинаково влияют на выбор точечных объ-

ектов, так как точку нельзя выбрать частично. Все указанные опции проиллю-

стрированы на рисунке 1.14. 

 

 
Рис. 1.14. Опции выбора в рамке (слева направо): features partially or completely within the 

box, features completely within the box, features that the box are completely within 

 

В программе существуют также следующие методы выборки, доступные 

из меню Selection → Interactive Selection Methods: 

1) Создать новую выборку (Create New Selection). Если на карте уже есть 

выбранные объекты, будущий выбор объектов полностью отменит текущую 

выборку, создав новую выборку объектов. 

2) Добавить к текущей выборке (Add To Current Selection). Текущая вы-

борка не отменяется, новые выбираемые объекты к ней добавляются. Количе-

ство выбранных объектов может либо возрастать, либо быть прежним. 

3) Удалить из текущей выборки (Remove From Current Selection). Новые 

выбираемые объекты отменяются из текущей выборки. Если выборки на карте 
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нет, данный метод не имеет смысла, так как ни один новый объект этим мето-

дом выбран не будет. Количество выбранных объектов не может возрастать.  

4) Выбрать из текущей выборки (Select From Current Selection). Новые 

выбираемые объекты, принадлежащие текущей выборке на карте, остаются в 

выборке, остальные – отменяются из выборки. Аналогично удалению из теку-

щей выборки (см. пункт выше), данный метод не имеет смысла, если на карте 

отсутствуют выбранные объекты. Количество выбранных объектов остается 

либо прежним, либо уменьшается. 

Сохраните все изменения в вашем *.mxd-документе. В документе должны 

быть: 

1) Четыре добавленных слоя – STATES, COUNTIES, LAKES, CITIES; 

2) 25% прозрачность или стиль Hollow для слоя STATES; 

3) Определяющий запрос для показа объектов слоя CITIES только со ста-

тусом столиц штатов или с населением более 1 млн. человек; 

4) Масштабный эффект для слоя CITIES; 

5) Пространственная закладка для одного из объектов слоя STATES; 

6) Измененные опции выбора объектов (стиль представления выбранных 

объектов, измененный параметр Selection tolerance). 

7) Новый созданный слой CITIES_1 в формате *.lyr 

 

Вопросы для самоконтроля: 

1) Какие основные вкладки содержит программа ArcCatalog? Для чего 

они предназначены? 

2) Какие параметры (настройки) влияют на видимость объектов слоев на 

карте ArcMap? 

3) Как измерить расстояние между объектами в окне карты? 

4) Что такое проект *.mxd? Какие параметры он хранит? 

5) Как создать новый слой в программе ArcMap? 

6) Какие способы навигации в окне карты вам известны? 

7) Что такое «пространственная закладка»? Какие способы создания про-

странственных закладок вы знаете? 

8) Какие опции и методы выбора объектов на карте вам известны? В чем 

они заключаются? 
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Практикум 2. Работа с атрибутивными таблицами 

 

Цель: исследовать функциональность ArcMap на предмет работы с таб-

лицами атрибутивных данных. 

Задачи: 1. Исследовать функциональность  по добавлению новых полей в 

атрибутивные таблицы. 

2. Научиться сортировать записи по колонкам таблиц. 

3. Создать таблицу обобщения записей для одного из слоев. 

4. Исследовать работу инструмента Identify. 

Исходные данные: shape-файлы STATES, CITIES, COUNTIES из каталога 

…\practicum_data\ArcGIS_data\usa 

 

Работа пользователя в программном интерфейсе 

 

1. Запустите программу ArcMap. Добавьте все учебные слои на карту.  

2. В таблице содержания нажмите правой кнопкой мыши на слое  

STATES. В контекстном меню выберите Open Attribute Table (Открыть атри-

бутивную таблицу) – откроется атрибутивная таблица слоя штатов. 

3. Промотайте таблицу вправо-влево и вниз-вверх, используя нижний и 

боковой скроллы. Изучите таким способом данные о штатах. 

4. Нажмите правой кнопкой мыши на заголовке текстового поля таблицы, 

например, на заголовке колонки STATE_ABBR. В контекстном меню выберите 

Properties (Свойства), чтобы открыть окно свойств Field Properties (рис. 2.1).  

 

 
Рис. 2.1. Окно Field Properties для поля типа String 
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5. В окне свойств колонки отредактируйте поле Ailas (альтернативное 

имя), например, удалите часть “STATE_”.   

Обратите внимание, что в поле Length (Длина) показано количество воз-

можных символов, из которых может состоять содержание ячейки данной ко-

лонки. Для STATE_ABBR длина поля равна 2, чего вполне достаточно, чтобы 

записать короткое буквенное обозначение каждого из штатов. 

6. Нажмите ОК в окне свойств колонки – заглавие колонки в таблице ат-

рибутов поменяется на «ABBR». 

7. Откройте окно свойств какого-нибудь поля с числовыми данными, на-

пример, поля AREA. В групбоксе Data, в поле Precision  установлено макси-

мальное количество знаков, из которых может состоять число (не включая за-

пятую), в поле Scale – максимальное количество знаков, которое можно поста-

вить после запятой.  Сейчас количество знаков после запятой равно трем. 

8. Нажмите на кнопку Numeric для открытия диалога Number Format.  

9. Для опции Number of decimal places  (групбокс Rounding окна Number 

Format) замените значение 3 на 2 (рис. 2.2). Нажмите ОК в окнах Number 

Format и Field Properties. Значения в поле AREA будут представлены с точно-

стью до 2 знаков после запятой. 

10. Нажмите правой кнопкой мыши на поле AREA и выберите Turn Field 

Off (Отключить поле) – колонка АREA будет скрыта. 

 

 
Рис. 2.2. Настройка отображения требуемого количества  

знаков после запятой для числовых полей таблицы атрибутов 

 

Просмотреть перечень полей атрибутивной таблицы и их свойства можно 

в окне свойств слоя. 

1. Не закрывая атрибутивную таблицу, нажмите правой кнопкой на слое 

штатов в таблице содержания. В появившемся контекстном меню выберите 

Properties, чтобы открыть окно свойств слоя. 

2. Перейдите на вкладку Fields (Поля) в окне свойств слоя штатов.  

Вкладка содержит перечень названий всех полей, их альтернативных имен, ти-

пов хранимых данных, размеры. На этой вкладке также можно включить / от-

ключить видимость поля, вызвать диалог форматирования чисел. 

3. Включите чекбокс видимости поля AREA и нажмите ОК в диалоге 
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свойств слоя – колонка AREA будет вновь видна в таблице атрибутов слоя шта-

тов. 

Для полей можно менять их ширину и расположение в таблице. Для сме-

ны ширины поля нужно навести курсор на его границу, чтобы он приобрел со-

ответствующую форму (рис. 2.3), а потом растянуть колонку в сторону, увели-

чивая таким способом ее ширину.  

 

 
Рис. 2.3. Изменение ширины поля в таблице атрибутов 

 

Для смены положения колонки в таблице достаточно нажать курсором на 

ее заглавии и, удерживая нажатой левую клавишу мыши, перетащить колонку в 

нужное место. 

Теперь рассмотрим некоторые особенности работы с выбранными стро-

ками. 

1. Удерживая нажатой клавишу Ctrl, выделите несколько строк в таблице 

(рис. 2.4).  Для этого нажимайте на рамку таблицы слева от начала строки. 

 

 
Рис. 2.4. Таблица атрибутов слоя STATES с выбранными записями 

 

Обратите внимание, что соответствующие штаты выбираются и на карте. 

2. Нажмите на кнопку Selected внизу окна атрибутивной таблицы – в 

таблице показаны только выбранные строки, остальные – скрыты. 

3. Нажмите кнопку All – вновь показаны все строки, и выбранные и нет. 

4. Выполните команду Options (кнопка в окне таблицы) → Switсh 

Selection – ваша выборка обращена. 

5. Выполните команду Options → Select All – выбраны все строки 

таблицы. 
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6. Выполните команду Options → Clear Selection – выборка сброшена. 

Кнопка Options позволяет выполнять и ряд других важных операций с 

таблицами, некоторые из которых мы рассмотрим в следующих разделах. 

Среди них: Find&Replace (поиск и замена записей), Select By Attribute (выбор 

записей по значениям их атрибутов), Join and Relates (позволяет объединять 

таблицы, создавать связи между таблицами), Export (экспорт таблиц в *.dbf- 

формат). Наша задача – добавить в таблицу два новых поля, в которые мы 

поместим значения прироста населения с 1990 по 2010 год (в количестве 

жителей) и плотность населения на 2010 год. 

1. В окне таблицы для слоя штатов нажмите на кнопку Options (Опции), а 

в списке опций выберите команду Add Field (Добавить поле). 

2. В окне Add field неазовите новое поле как DENSITY, установите тип 

поля Double, количество знаков – 7, количество возможных знаков после 

запятой – 2 (рис. 2.5). 

 
Рис. 2.5. Параметры нового поля типа Double 

 

3. Нажмите ОК в окне добавления поля. В таблице появится новая 

колонка. 

4. Нажмите правой кнопкой мыши на названии только что добавленного 

вами поля и в появившемся контекстном меню выберите Field Calculator 

(Калькулятор поля). Проигнорируйте сообщение о том, что текущий слой 

является нередактируемым. 

5. В окне Field calculator вбейте формулу рассчета плотности населения 

на основании имеющихся значений полей POP2010 и AREA (рис. 2.6). 
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Рис. 2.6. Выражение для расчета значений нового поля DENSITY 

 

6. Нажмите ОК. После того как поле DENSITY заполнится значениями, 

нажмите правой кнопкой мыши на заголовке поля и выберите Statistics – 

появится окно Statistic of STATES, содержащее гистограмму и основные 

показатели распределения по полю плотности. В выпадающем списке Field 

пользователь может изменить поле для отображения статистики. 

7. Отсортируйте значения в поле DENSITY. Из контекстного меню 

колонки выберите Sort Descending (сортировка по спаданию) или Sort Ascending 

(по наростанию). Записи будут отсортированы соответствующим образом. 

8. Самостоятельно создайте новое поле и рассчитайте в него абсолютный 

прирост населения (количество человек) по штатам с 1990 по 2010 год. 

Перед началом расчетов по полям таблиц убедитесь, что в таблице нет 

выбранных строк. Иначе расчеты будут проводится только для выбранных 

записей,  а остальные строки будут проигнорированы. 

В числовых колонках также могут быть рассчитаны некоторые 

характеристики геометрии векторных объектов: 

 X/ Y координаты точечных объектов; 

 X/ Y координаты центроида, начального и конечного узлов, общая 

длина для полилинии. 

 X/ Y координаты центроида, периметр и площадь полигона. 

Обратите внимание, что рассчитать длины полилиний, значения площа-

дей и периметров полигонов нельзя, если Вы используете географическую ко-

ординатную систему, где единицами измерения координат выступают градусы. 

Еще одна полезная функциональность при работе с таблицами – создание 

таблиц обобщения. Создадим такую таблицу на основании данных о принад-

лежности штатов к одному из субрегионов. Результирующая таблица должна 

включать поля: название субрегиона, площадь субрегиона, средняя плотность 

населения в субрегионе, количество штатов. 

1. Нажмите правой кнопкой мыши на заголовке поля SUB_REGION. 

2. В контекстном меню выберите Summarize. 

3. В окне Summarize проверьте, что поле суммирования – SUB_REGION; 

для поля AREA установите способ обобщения Sum, а для поля DENSITY – 

Average (рис. 2.7). 
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Рис. 2.7. Окно обобщения записей таблицы STATES по полю SUB_REGION 

 

4. Укажите каталог для сохранения итоговой таблицы и нажмите ОК. 

Подтвердите добавление таблицы в программу ArcMap. 

В результате вы получите таблицу обобщения (рис. 2.8), где будут 

рассчитаны значения (сумма, среднее) для выбранных атрибутов по всем 

относящимся к конкретному субрегиону ГИС-объектам штатов.  

 

 
Рис. 2.8. Результат обобщения записей таблицы STATES по полю SUB_REGION 

 

Быстро получить информацию об интересующем Вас объекте (ах) на кар-

те можно при помощи инструмента Identify. Не обязательно открывать атрибу-

тивную таблицу слоя для того, чтобы просмотреть данные по одному-двум 

ГИС-объектам карты. По умолчанию окно Identify будет заполнено данными из 

атрибутивной таблицы самого верхнего слоя (Top-most layer). В выпадающем 

списке Identify from (рис. 2.9) пользователь также может установить требуемые 
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слои для извлечения данных из их атрибутивных таблиц в окно Іdentify. Это 

может быть как конкретный слой, так и Все слои (All layers), все Видимые слои 

(Visible layers) или все Выбираемые слои (Selectable layers). 

 

 
Рис. 2.9. Выбор слоя (слоев) для извлечения записей инструментом Identify 

 

1. Выберите инструмент   Identify на панели Tools – появится окно 

Identify для представления атрибутивных данных о требуемых ГИС-объектах. 

2. В выпадающем списке Identify from установите слой STATES. 

3. Кликните инструментом Identify на одном из объектов штатов – окно 

Identify заполнится атрибутивными данными для указанного штата. 

4. Кликните инструментом  Identify на одном из объектов городов. Какие 

данные представлены в окне Identify? 

5. В выпадающем списке Identify from установите All layers.  Кликните 

инструментом  Identify на одном из объектов городов – будут представлены 

данные как по объекту слоя городов, так и по остальным объектам слоев, кото-

рые находятся в ближайшей окрестности от указанного вами инструментом 

Identify местоположения (рис. 2.10). 

 

 
Рис. 2.10. Окно Identify для объектов слоев окна карты 
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Результатом самостоятельной работы с атрибутивными таблицами долж-

ны быть: 

1) Два новых добавленных поля со значениями прироста населения и 

плотности населения по штатам; 

2) Таблица обобщения для слоя STATES; 

3) Изменения в представлении данных в таблице атрибутов слоя (пере-

именованное альтернативное имя колонки, округление до заданного числа зна-

ков после запятой, сортировка записей). 

 

Вопросы для самоконтроля: 

1. Как создать новое поле в таблице атрибутов? 

2. Какое предназначение инструмента Identify? Для каких групп слоев 

возможно представление атрибутивных данных в окне Identify? 

3. Как отсортировать записи в атрибутивной таблице? 

4. Какие параметры входят в состав диалога добавления нового поля? Что 

они означают? 

5. Как рассчитать значения в ячейках полей на основе существующих за-

писей таблицы? 

6. Какие характеристики геометрии векторных ГИС-объектов могут быть 

рассчитаны в полях атрибутивных таблиц? 

7. Как выполнить обобщение записей в атрибутивной таблице? 

8. Какие статистические показатели можно просмотреть в окне статисти-

ки по колонке? 

9. Какие способы обобщения записей  предоставляет функциональность 

Summarize? 

10. Какие свойства полей таблиц можно просмотреть/ задать на вкладке 

Fields окна свойств слоя? 
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Практикум 3. Выборки и запросы 

 

Цель: исследовать способы выбора ГИС-объектов на основании про-

странственных и атрибутивных запросов. 

Задачи: 1. Исследовать способы выполнения атрибутивных запросов; 

2. Рассмотреть способы выполнения пространственных запросов на осно-

ве различных пространственных соотношений между ГИС-объектами слоев. 

Исходные данные: shape-файлы STATES, LAKES, COUNTIES, Rivers и 

слой CITIES.lyr из каталога …\practicum_data\ArcGIS_data\usa 

 

Работа пользователя в программном интерфейсе 

 

В практикуме 1 мы уже рассматривали некоторые способы выбора объек-

тов в окне карты при помощи инструмента Select Features. В данном практику-

ме рассматриваются выборки на основании запросов. 

В программе ArcGIS есть два основных способа выполнения запросов для 

получения соответствующих им выборок: запросы по атрибуту и запросы по 

пространственному положению. Следует отличать понятия «запрос» и «вы-

борка». Выборка в ГИС – это или некоторая часть объектов генеральной со-

вокупности, или все объекты слоя сразу, выделенные на карте либо вручную, 

либо по некоторому критерию. Запрос – это, собственно, и есть критерий бу-

дущей выборки, записанный в форме однозначного выражения. 

Реализация запросов в форме выполнения выборок подразумевает ранее 

описанные в практикуме 1 способы: новый выбор, выбор из выборки, добавле-

ние выборки к текущей выборке, отмена выборки для части ранее выбранных 

объектов. Учитывая наличие указанных способов выполнения выбора, можно 

комбинировать атрибутивные и пространственные запросы.  

Добавьте в ArcMap ранее использовавшиеся вами shape-файлы на терри-

торию США: STATES, LAKES, COUNTIES, Rivers и слой CITIES.lyr. 

 

Атрибутивные запросы 

Задание 1. Выбрать все объекты слоя CITIES.lyr со статусом столиц 

1. Включите полный экстент для всех слоев. Отключите видимость слоя 

COUNTIES. 

2. Выполните команду меню Selection → Select By Attributes. 

3. В появившемся окне Select By Attributes, в выпадающем списке Layer  

установите слой CITIES. 

4. В выпадающем списке Method  установите Сreate a new selection. 

5. В поле построения запроса SELECT * FROM CITIES WHERE введите 
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следующий запрос: "CAPITAL" = 'Y' (рис. 3.1).  

Для ввода этого запроса вы также можете использовать различные кноп-

ки окна Select By Attributes. В поле с перечнем колонок таблицы городов найди-

те CAPITAL. Сделайте на ней двойной клик – имя колонки CAPITAL, с учетом 

значений которой вы будете выполнять запрос, запишется в поле для построе-

ния выражения. После этого нажмите на кнопку «=». Для завершения построе-

ния запроса нажмите на кнопку Get Unique Values (Получить уникальные зна-

чения) – в поле сверху от кнопки будут выведены все уникальные записи по ко-

лонке CAPITAL слоя CITIES. Как видите, для любого объекта слоя городов в 

поле CAPITAL может быть одно из двух значений: либо «Y», либо «N» (город 

либо столичный, либо нет). 

Здесь стоит заметить, что помимо знака «=», в запросах по текстовым по-

лям (то есть по полям типа String) можно применять знак «<>» (не равно).  

 

 
Рис. 3.1. Окно Select By Attributes. Запрос для выбора столиц штатов 

 

6. Нажмите ОК в окне построения атрибутивных запросов – на карте бу-
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дут подсвечены все города, которые являются столицами штатов (рис. 3.2). 

 

 
Рис. 3.2. Результат выбора объектов слоя CITIES со столичным статусом 

 

Задание 2. Выбрать столицы штатов с населением более 500 тыс.чел.  

Усложним запрос: вас интересуют все города со столичным статусом, ко-

торые при этом имеют население более полумиллиона человек. Сделать выбор-

ку в данном случае можно двумя способами. 

1 способ 

1. Откройте окно Select By Attributes. Окно содержит предыдущий запрос 

"CAPITAL" = 'Y'. 

2. Допечатайте к предыдущему запросу часть AND "POP2010" > 500000 

(рис. 3.3). 

3. Нажмите ОК в окне Select By Attributes – только 4 объекта будут удов-

летворять данному критерию выбора (рис. 3.4). 

 

 
Рис. 3.3. Запрос для выбора столиц штатов с населением более 500 тыс.чел. 

 

 
Рис. 3.4. Выборка столиц штатов с населением более 500 тыс. человек 
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2 способ: 

1. Снимите выборку со всех объектов, нажав кнопку Clear Selected 

Features на панели Tools. 

2. Откройте окно выбора по атрибутивному запросу. 

3. Нажмите кнопку Сlear, чтобы очистить содержание предыдущего за-

проса. 

4. Введите запрос "CAPITAL" = 'Y', как вы это делали раньше, а затем 

нажмите Apply – вы получите выборку объектов карты как на рис. 3.2. 

5. Теперь, вместо того, чтобы дописывать вторую часть критерия выбор-

ки, используя AND, нажмите кнопку Clear, чтобы очистить содержание выра-

жения. 

6. Наберите "POP2010" > 500000. 

7. В выпадающем списке Method установите Select from current selection. 

8. Нажмите ОК. 

Вы получите выборку аналогичную той, которая была в первом способе. 

Метод Select from current selection работает в данном случае как оператор логи-

ческого умножения AND, использовавшийся вами в первом способе. 

Рассмотрим примеры построения выражений с использованием в запро-

сах OR, IS, LIKE, NOT. 

Задание 3. Выбрать штаты, входящие в состав субрегионов Pacific 

(Тихоокеанский) или Mtn (сокращение от Mountain – Горный), кроме шта-

та Калифорния 

Принадлежность штата к тому или иному субрегиону определяется соот-

ветствующей записью в поле SUB_REGION.  Естественно, что один и тот же 

штат не может относиться одновременно к двум субрегионам. Вы должны 

сформулировать запрос, по которому будут выбраны штаты либо входящие в 

один субрегион, либо – в другой. Для этого в запросах используют логическое 

сложение OR. 

1.  Снимите выборку со всех объектов, нажав на кнопку Clear Selected 

Features на панели Tools. 

2. Откройте окно выбора по атрибутивному запросу. 

3. Нажмите кнопку Сlear, чтобы очистить содержание предыдущего за-

проса. 

4. В выпадающем списке Layer установите STATES. Способ выборки – 

Create a new selection. 

5. В поле для выражения введите "SUB_REGION"= 'Pacific' OR 

"SUB_REGION"='Mtn'. 

6. Нажмите ОК – все штаты субрегионов Тихоокеанский и Горный будут 

выделены.  
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Теперь рассмотрим работу части NOT при построении запросов. Итак, 

вам необходимо выбрать все штаты Тихоокеанского и Горного районов, за ис-

ключением штата Калифорния. 

1. Откройте окно построения атрибутивных запросов, текущее выражение 

возьмите в скобки и допечатайте AND NOT "STATE_NAME" = 'California' 

(рис. 3.5). 

2. Нажмите ОК  – выборка со штата Калифорния будет снята (рис. 3.6). 

 

 
Рис. 3.5. Запрос для выбора штатов Тихоокеанского и Горного субрегионов,  

кроме штата Калифорния  

 

 

 
Рис. 3.6. Выборка по заданию 3 

 

Слово LIKE используется для поиска записей, которые содержат часть 

слова. Например, вы хотите найти все штаты, начинающиеся на «New» («Но-

вый»). 

1. Откройте окно построения атрибутивных запросов. 

2. Нажмите кнопку Clear, чтобы очистить текущее выражение. 

3. В поле для выражения введите "STATE_NAME" LIKE 'New%' 

4. Нажмите ОК – в окне карты будут выбраны четыре штата, начинаю-

щиеся на «Нью»: Нью-Йорк, Нью-Джерси, Нью-Мексико, Нью-Гемпшир. 

Выражения запросов можно сохранять. Для этого следует нажать кнопку 

Save и сохранить файл Expression.exp в нужную директорию. Открыть сохра-

ненный ранее файл выражения можно, нажав клавишу Load. 
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Выбор по местоположению.  

ArcGIS 9.3.1. использует тринадцать пространственных отношений для 

выбора объектов по взаимному расположению. Рассмотрим некоторые из них.  

 

Intersect (Пересекаются) 

Выберем все штаты, которые имеют выход к реке Коннектикут. 

1. Отмените все выборки на карте, если такие имеются. 

2. Для удобства подпишите названия штатов, выбрав команду Label 

Features из контекстного меню слоя в таблице содержания слоев. 

3. Снимите видимость для всех слоев кроме STATES и Rivers. 

4. Выполните команду меню Edit → Find.  

5. Инструментом Find (см. практикум 1) найдите реку Коннектикут (англ. 

Connecticut, пересекает территорию одноименного штата) из слоя Rivers, на-

строив поиск как в примере на рисунке 3.7. 

 

 
Рис. 3.7. Окно поиска реки Коннектикут из слоя Rivers (фрагмент) 

 

6. Нажмите правой кнопкой мыши на найденном объекте слоя рек и вы-

берите в контекстном меню команду Select.  

7. Откройте снова контекстное меню на найденном объекте 

«Connecticut». Выберите команду Pan to – выбранный объект будет показан по 

центру фрейма данных. Закройте окно Find. 

8. Выполните команду меню Selection → Select By Location. 

9. В окне выбора по запросу установите следующие параметры: 

 Способ выбора – select features from (выбрать объекты из);  

 Слой, из которого будете выбирать (целевой слой)  – STATES; 

 Пространственное отношение – intersect (пересекают); 

 Слой, по которому будете выбирать (исходный слой) – Rivers; 

 Чекбокс Use selected features (Использовать выбранные объекты) 

включен. 

Остальные чекбоксы оставьте выключенными. Установки для выбора, ко-
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торые вы только что сделали, выполняют следующую команду: выбрать в но-

вую выборку все объекты слоя STATES, которые пересекаются выбранным 

(чекбокс Use selected features включен) объектом слоя Rivers. 

10. Нажмите Apply в окне Select By Location – вы получите выборку всех 

объектов слоя штатов, которые пересекаются или соприкасаются (хотя бы в од-

ном узле) с полилинией выбранной реки Коннектикут (см. рис. 3.8). 

 

Share a line segment (Объекты имеют общий отрезок) 

В текущих настройках выбора в окне Select Вy Location измените про-

странственное отношение на share a line segment и нажмите Apply – количество 

выбранных объектов уменьшится: выбранными будут только те полигоны 

штатов (в примере – Вермонт и Нью-Гемпшир), которые граничат с рекой, то 

есть имеют хотя бы один фрагмент (отрезок между парой соседних узлов), 

который в точности совпадает с фрагментом выбранного объекта слоя Rivers. 

 

Are crossed by the outline of (Пересекаются контуром) 

В текущих настройках выбора в окне Select by Location измените про-

странственное отношение на are crossed by the outline of и нажмите Apply – 

будут выбраны только те штаты, контур которых пересекается выбранным 

ранее ГИС-объектом реки. При этом объекты целевого и исходного слоев не 

должны иметь совпадающих фрагментов. 

Пространственные отношения, описанные выше, проиллюстрированы на 

рисунке 3.8. 

 
Рис. 3.8. Результаты выбора штатов по критериям пространственного положения 

относительно выбранной полилинии рек  
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Are within a distance of (Находятся в пределах расстояния)  

Выберем все объекты слоя городов, удаленные от реки Миссисипи не бо-

лее чем на 300 км. 

1. Закройте окно выбора по расположению. 

2. Снимите выборку со всех объектов слоев штатов и рек. 

3. При помощи инструмента Find найдите реку Миссисипи (название 

Mississippi, слой Rivers). 

4. Для найденного объекта Mississippi в окне Find откройте контекстное 

меню, а в нем выберите сначала Select, а затем Pan to – река будет выбрана и 

расположена строго по центру фрейма данных. 

5. Откройте окно Select By Location. Установите следующие параметры: 

 Способ выбора – select features from (выбрать объекты из);  

 Слой, из которого будете выбирать – CITIES (остальные чекбоксы сня-

ты); 

 Пространственное отношение – are within a distance of; 

 Слой по которому будете выбирать – Rivers; 

 Чекбокс Use selected features (Использовать Выбранные Объекты) 

включен; 

 Чекбокс Apply a buffer to the features in Rivers включен, в качестве еди-

ниц измерения установлены километры, дистанция – 300 км. 

6. Нажмите Apply – объекты слоя городов в пределах 300-километрового 

буфера от реки будут выбраны (рис. 3.9).   

 

 
Рис. 3.9. Выборка объектов слоя CITIES.lyr, расположенных   

не далее 300 км от реки Миссисипи 

 

Contain (Содержат) 

Способ позволяет выбирать объекты целевого слоя, содержащие внутри 

себя объекты исходного слоя. Примером такого отношения являются ГИС-

объекты территориальных единиц разного уровня: область (штат) «внутри» со-

держит район. При этом границы области и района могут частично совпадать. 
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1. Закройте окно выбора по расположению. 

2. Снимите выборку со всех объектов слоев. 

3. При помощи инструмента Find найдите округ Арустук (название 

Aroostook, слой COUNTIES). 

4. Для найденного объекта Aroostook в окне Find откройте контекстное 

меню, а в нем выберите сначала Select, а затем Pan to – округ будет выбран и 

расположен строго по центру фрейма карты. 

5. Откройте окно Select By Location. Установите следующие параметры: 

 Способ выбора – select features from (выбрать объекты из);  

 Слой, из которого будете выбирать – STATES (остальные сняты); 

 Пространственное отношение – contain; 

 Слой, по которому будете выбирать – COUNTIES; 

 Чекбокс Use selected features (использовать выбранные объекты) вклю-

чен; 

 Чекбокс Apply a buffer to the features in… отключен. 

6. Нажмите Apply – штат Мэн, который содержит округ Aroostook, будет 

выбран.  

 

Completely contain (Полностью содержат) 

Способ позволяет выбирать объекты целевого слоя, содержащие внутри 

объекты исходного слоя. При этом границы объектов слоев НЕ должны иметь 

общих узлов. Если проводить аналогию с административно-территориальными 

единицами областей и районов, то полигональный объект области (целевой) 

выберется лишь в том случае, когда выбранный ранее объект района (исход-

ный) НЕ будет приграничным, а будет целиком располагаться внутри области, 

НЕ имея с границей области ни одного общего узла. 

1. В окне Select By Location смените пространственное отношение с 

contain на completely contain. 

2. Нажмите Apply – выборка с объектов штатов будет сброшена, так как 

граница выбранного в исходном слое COUNTIES объекта Aroostook частично 

совпадает с границей штата Мэн, что не удовлетворяет требованиям простран-

ственного отношения Completely contain. 

 

Are within (Находятся в пределах)  

Пространственные отношения Are within и Contain отличаются друг от 

друга тем, что целевой и исходный объекты в них словно бы меняются места-

ми. Если в случае с Contain выбираются объекты, которые содержат другие 

объекты, то в Are within – объекты, которые содержаться внутри других. Вы-

бранными будут те объекты, которые или целиком находятся на границе ис-
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ходного объекта, или расположены внутри: полностью или частично (имеют с 

границей исходного объекта общие узлы). 

1. Инструментом Select Features выберите на карте штат Мэн.  

2. Откройте окно Select By Location с параметрами, оставшимися после 

предыдущего запроса для Completely contain. Установите новые параметры: 

 Способ выбора – select features from (выбрать объекты из);  

 Слой, из которого будете выбирать – COUNTIES (остальные сняты); 

 Пространственное отношение – are within; 

 Слой, по которому будете выбирать – STATES; 

 Чекбокс Use selected features (использовать выбранные объекты) вклю-

чен; 

 Чекбокс Apply a buffer to the features in… отключен. 

3. Нажмите Apply – все округа в выбранном объекте слоя штатов будут 

выделены (рис. 3.11). 

 

Are completely within (Находятся полностью внутри) 

Как и в случае с Completely contain, пространственное отношение Are 

completely within не учитывает целевые объекты, узлы которых расположены на 

границах исходных. Если проводить аналогию с единицами административно-

территориального деления разного уровня, то для исходного объекта типа об-

ласть (штат) выбраны будут только те объекты районов (округов), которые на-

ходятся в пределах области, но не являются приграничными (не имеют с конту-

рами целевого объекта области общих узлов). 

1. Откройте окно Select By Location с параметрами, оставшимися после 

предыдущего запроса с Are within, где выбранными были все округа штата Мэн. 

Смените пространственное отношение на are completely within. 

2. Нажмите Apply – в пределах исходного объекта штатов будут выделены 

все округа кроме приграничных (рис. 3.11). 

Если же вам нужно выбрать приграничные округа, а выборку внутренних 

округов сбросить, необходимо выполнить следующие действия: 

1. В окне Select By Location установить способ выбора select features from, 

пространственное отношение – are within и нажать Apply для выбора всех объ-

ектов внутри полигона исходного слоя штатов. 

2. В окне Select By Location сменить способ выбора на remove from the 

currently selected features in, а пространственное отношение – на are completely 

within. Нажмите ОК – выберутся только приграничные округа в пределах за-

данного штата. 

Некоторые другие способы пространственных отношений, используемые 

в выборках, описаны ниже. 
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Рис. 3.11. Сравнение результатов выбора округов на основе пространственных отношений  

«находятся в пределах» и «полностью находятся в пределах»  

(для выбранного ранее исходного объекта слоя штатов) 

 

Contain (Clementini) (Содержат (Clementini))  

При применении данного пространственного отношения выбираются все 

объекты целевого слоя, которые содержат объекты исходного слоя. Не выби-

раются объекты целевого слоя, содержащие объекты исходного слоя только на 

своей границе: хотя бы один узел должен попадать в пределы объектов целево-

го слоя. 

 

Are Within (Clementini) (Находятся в пределах (Clementini)).  

При применении данного пространственного отношения выбираются все 

объекты целевого слоя, расположенные в пределах объектов исходного слоя. 

Не выбираются те объекты, которые целиком расположены на границе объек-

тов исходного слоя: хотя бы один узел должен попадать в пределы объектов 

исходного слоя. 

 

Are identical to (Идентичны) 

Будут выбраны объекты целевого слоя, геометрия которых идентична 

объектам исходного слоя. Тип слоя (точки, линии или полигоны) у целевого и 

исходного слоя должны совпадать. 

 

Have their centroid in (Имеют центроид внутри) 

Выбираются объекты целевого слоя, центроид которых находится в пре-

делах или на границах исходного слоя. 
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Touch the boundary of (Касаются границы) 

Выбираются объекты целевого слоя, у которых узлы или отдельные 

фрагменты касаются границ объектов исходного слоя, но не пересекают их. 

 

Комбинирование пространственных и атрибутивных запросов 

Выполнить сначала пространственный, а затем атрибутивный запрос, или 

наоборот, необходимо, если критерий отбора объектов включает в себя как 

особенности их пространственного положения, так и атрибутивные характери-

стики. Например, вам необходимо выбрать все имеющие выход к реке районы 

(округа) с населением больше заданного. В этом случае вам сначала нужно вы-

брать все приграничные районы, независимо от их численности населения, ис-

пользуя функциональность Select By Location (способ select features from и про-

странственное отношение intersect). На втором этапе выборки вы должны ис-

пользовать функциональность Select By Attribute (способ select from the current 

selection, критерий выбора – все объекты слоя с численностью населения боль-

ше заданной). 

 

Вопросы для самоконтроля: 

1. Какие виды пространственных отношений используются при выборе 

объектов на карте? 

2. В чем заключаются особенности выбора ГИС-объектов: новый выбор, 

выбор из текущей выборки, добавление к текущей выборке? 

3. Что называется выборкой в ГИС? Атрибутивная и пространственная 

выборки в пакете ArcGIS. 

4. Использование логических операторов в атрибутивном запросе. 

5. Чем отличаются пространственные отношения Are within и Are com-

pletely within? 

6. Чем отличаются пространственные отношения Are within и Contain? 

7. В каком пространственном отношении можно выбрать максимальное 

количество объектов целевого слоя? 
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Практикум 4. Разработка тематических карт в ArcGIS 9.3.1 

 

Цель: научиться создавать тематические карты, используя функциональ-

ность пакета ArcGIS. 

Задачи: 1. Исследовать способы символизации (придания объектам сти-

лей в зависимости от их атрибутов) в программе ArcGIS 9.3.1. 

2. Рассмотреть способы подписывания ГИС-объектов, создания и редак-

тирования аннотаций. 

3. Исследовать особенности работы в режиме Layout View, разработать 

компоновку карты. 

4. Рассмотреть работу одного-двух инструментов ArcToolbox. 

Исходные данные:  shape-файлы Cities, Rivers, Countries из набора дан-

ных «аfrica»; shape-файлы STATES.shp и LAKES.shp из набора «usa»; электрон-

ная таблица Energy.xls. 

 

Работа пользователя в программном интерфейсе 

 

Тематическое картографирование в ГИС – это способ визуализации 

пространственных данных, основанный на присвоении элементарным состав-

ляющим геоинформационной модели (точкам, линиям, полигонам, ячейкам 

растра) определенных стилей изображения, в зависимости от значений непро-

странственных характеристик в атрибутивных базах данных.  

Составляющими определенного стиля могут быть: 

 цвета точек, линий, полигонов; 

 растяжка цветовой раскраски для ячеек растровых моделей данных; 

 размер точечного объекта; 

 внешний вид точечного объекта (кружочек, квадратик, другой значок); 

 тип линии (сплошная, пунктирная, точками и т.д.); 

 толщина линии; 

 заливка полигона (сплошная, штриховка, отсутствует); 

 толщина и тип контура полигона и другие. 

В ArcMap есть следующие способы визуализации атрибутов (символиза-

ции): 

1. Features, Single Symbol – Гис-объекты, один символ. Способ исполь-

зуется для векторных слоев. Все объекты слоя имеют идентичный стиль. 

2. Categories – Категории. В соответствии с этим способом, все объекты 

слоя, имеющие идентичные значения по одному из атрибутов (способ Catego-

ries - unique values) или сразу по нескольким атрибутам (способ Categories - 

Unique values, many fields), могут быть визуализированы идентичным стилем. 
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3. Quantities – Количество. В этом способе размер символа, толщина ли-

нии или интенсивность раскраски объектов пропорциональны значению атри-

бута, по которому выполняется символизация. Например, чем больше плот-

ность населения административной единицы, тем интенсивнее штриховка на 

карте. Способ применяется для диапазонов числовых значений атрибутов век-

торных объектов: одинаковой градацией размера, толщины или интенсивности 

цвета (штриховки) визуализированы объекты, попадающие в заданный интер-

вал значений атрибута. Способ применяется также и для растровых данных. 

4. Charts – Графики – визуализация числовых значений при помощи кру-

говых и столбиковых диаграмм, которыми могут быть представлены сразу два 

и больше атрибутов ГИС-объектов.  

5. Multiplе attributes - Quantity by category. Можно отображать сразу не-

сколько атрибутов, причем как количественных, так и качественных (катего-

рий). Возможно использование сразу нескольких вариантов представления ат-

рибутов – цветами, толщиной линий, диаграммами.  

Рассмотрим некоторые из способов символизации. 

 

Single symbol 

Нажмите кнопку  Add Data (Добавить данные) на панели инструмен-

тов Standard, перейдите к набору геопространственных данных «africa» 

(…\practicum_data\arcgis_data\africa), выделите shape-файл Сountries и нажмите 

клавишу Add (Добавить). В окне карты появится слой со знакомыми очерта-

ниями африканского континента и его стран. 

При каждом новом добавлении того же самого shape-файла, заливка по-

лигонов стран может быть разной.  

Задание 1. «Раскрасить» Африку бежевым цветом, используя способ 

Single symbol  

1. Нажмите правой кнопкой мыши на слое Countries в таблице содержа-

ния. 

2. В контекстном меню слоя выберите команду Properties (Свойства). 

3. В окне свойств слоя перейдите на вкладку Symbology (Символизация). 

4. Выберите способ Features, Single symbol, в групбоксе Symbol нажмите 

на кнопку для выбора стиля объектов (рис. 4.1). 

5. В появившемся диалоговом окне Symbol Selector (Выбор стиля) рас-

кройте палетку цветов и выберите цвет Sahara Sand (рис. 4.2). 

6. Установите ширину контура полигонов (контрол Outline Widht) – 0,75. 

Цвет контура (в выпадающей палетке Outline Color) – Gray 60% (рис. 4.3).  

7. Нажмите ОК в окне Symbol Selector, чтобы применить указанные пара-

метры визуализации.  
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В результате слой Countries будет представлен в бежевом цвете, с серыми 

контурами стран. 

 

 
Рис. 4.1. Диалог настройки свойств слоя, вкладка Symbology, настройка способа визуализа-

ции Single symbol 

 

 
Рис. 4.2. Выбор цвета Sahara Sand в палетке цветов окна Symbol Selector 

 

Открыть Symbol selector еще проще, если кликнуть на квадратике стиля 

изображения полигонального слоя стран в таблице содержания. 
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Рис. 4.3. Настройка стиля для контура полигонального объекта 

 

Categories (Категории) 

Задание 2. При помощи способа категорий визуализируйте качест-

венные атрибуты слоя рек 

1. Добавьте к карте shape-файл Rivers из набора данных «africa». 

2. В таблице содержания нажмите правой кнопкой мыши на слое рек и 

выберите Open Attribute Тable (Открыть атрибутивную таблицу). Откроется 

таблица атрибутов слоя рек. Ее фрагмент показан на рисунке 4.4. 

Обратите внимание на следующие атрибуты, характеризующие реки: 

TYPE (Тип) – пересыхающие (intermittent) и постоянные (perennial); STATUS 

(Статус) – главные (main) и второстепенные (secondary); NAVIG – судоходные 

(navigable) и нет (nonnavigable). Попробуем визуализировать эти атрибуты на 

карте. 

 
Рис. 4.4. Таблица атрибутов слоя рек (фрагмент) 
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3. Закройте  атрибутивную таблицу и откройте окно свойств слоя Rivers. 

4. Выберите тип символизации Categories, Unique values (1 на рис. 4.5). В 

выпадающем списке полей для символизации выберите TYPE (2 на рис. 4.5), 

нажмите кнопку Add All Values (3 на рис 4.5) для добавления всех значений ко-

лонки TYPE, а затем выполните двойной клик на дефолтном стиле полилиний 

для пересыхающих рек (4 на рис 4.5). 

 

 
Рис. 4.5. Окно свойств слоя рек (фрагмент). Настройки для способа категорий по значению 

атрибута TYPE (номера на рисунке соответствуют описанию в тексте) 

 

5. В открывшемся диалоговом окне Style Selector выберите стиль Dashed 

4:4 (черная пунктирная линия). В групбоксе Options измените цвет линии с 

черного на темно-синий, выбрав его из палетки цветов. 

6. Нажмите ОК, а затем смените способ представления для рек типа 

Perennial, выбрав для них стиль линии River  (сплошная синяя линия толщиной 

1).  Теперь речная сеть материка представлена более естественным образом: 

пересыхающие реки изображены пунктирными линиями, постоянные – сплош-

ными, как это показано на рис. 4.6. (Прим.: на рис.4.6 и дальше показаны 
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фрагменты картосхем для западной части материка). 

 

 
Рис. 4.6. Визуализация рек способом категорий по данным поля TYPE (фрагмент) 

 

Предположим, вас интересуют только пересыхающие реки, а все осталь-

ные вы хотите сделать невидимыми.  

1. Откройте окно Symbol Selector для постоянных рек. 

2. В выпадающем списке палетки цветов полилинии выберите No Color.  

3. Нажмите ОК для применения настроек. 

Задание 3. Самостоятельно. Постройте картосхемы, как предложено на 

рисунках 4.7, 4.8 и в их описании. Для полилиний рек используйте синий цвет. 

1. Картосхема з главными (толстые сплошные линии) и второстепенными 

(тонкие сплошные) реками (рис. 4.7). Используйте значения поля STATUS. 

 

 
Рис. 4.7. Визуализация рек способом категорий по данным поля STATUS 

 

2. Картосхема с судоходными (толстые сплошные линии) и не судоход-

ными (тонкие сплошные) реками (рис. 4.8). Используйте значения поля NAVIG. 
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Рис. 4.8. Визуализация рек способом категорий по данным поля NAVIG 

 

Задание 4. Построить картосхему, на которой реки будут визуализи-

рованы в соответствии со значениями атрибутов двух полей: NAVIG и 

STATUS  

1. Откройте окно свойств слоя рек. 

2. Выберите способ Category, Unique values, many fields. 

3. В списках фрейма Value Fields (рис. 4.9) выберите NAVIG и STATUS. 

 

 
Рис. 4.9. Выбор полей для визуализации слоя  

атрибутов способом категорий (задание 4) 

 

4. Нажмите кнопку Add All Values. Вы получите перечень категорий для 

визуализации на основе данных двух полей таблицы (рис. 4.10).  

 

 
Рис. 4.10. Перечень категорий для визуализации (к заданию 4) 
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Этот перечень построен с учетом того, что каждая река может относиться 

как к одному из статусов (главная или нет), так и быть судоходной или нет. 

5. Отредактируйте дефолтные стили линий следующим образом: 

 судоходные реки будут определяться параметром цвета линии (светло-

синяя – не судоходные, темно-синяя – судоходные); 

 статус реки будет определяться толщиной (толстая – главные, тонкая – 

второстепенные). 

Например: судоходные главные реки – темно-синие толстые линии (рис. 

4.11). Сохраните результат построений по заданию как слой *.lyr, а затем вер-

ните рекам общий стиль (сплошная тонкая синяя линия для всех рек).   

 

 
Рис. 4.11. Результат визуализации слоя рек по заданию 4 

 

Задание 5. Чтобы реки не перегружали карту, отобразите только те из 

них, которые имеют статус главных 

1. Откройте окно свойств слоя рек. 

2. В окне Layer Properties перейдите на вкладку Definition Query (Опреде-

ляющий запрос). 

3. Нажмите кнопку Query Builder (Построитель запросов). 

4. Введите запрос «Status» = «main» (рис. 4.12). 

5. Два раза нажмите ОК.  

Таким образом, на вашей карте будут видны только главные реки, изо-

бражение речных систем будет представлено в значительно более генерализо-

ванной форме.  

Способ категорий вполне применим не только для линейных объектов, но 

и для площадных, а также точечных.  
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Рис. 4.12. Диалог Query Builder. Определяющий запрос для отображения главных рек 

  

Задание 6. Самостоятельно.  Из учебного набора “africa” добавьте к 

карте shape-файл Cities. По аналогии с предыдущими заданиями визуализируй-

те слой городов способом категорий: в зависимости от их столичного статуса. 

Столичные города обозначьте красным кружком с точкой в центре (стиль Circle 

7, размер 18), остальные – черным кружком такого же размера (стиль Circle 1). 

Используйте поле CAPITAL со значениями Y (“Yes”) – «столица» и N (“No”) – 

«не столица». Итоговая модель должна соответствовать рис. 4.13. 

 

 
Рис. 4.13. Результат визуализации городов по заданию 6 (фрагмент) 
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Quantities – количественный способ 

Задание 7. Построить картосхему, иллюстрирующую количество жи-

телей городов способом Градуированный символ 

1. Нажмите правой кнопкой мыши на слое городов, скопируйте слой. 

2. В таблице содержания нажмите правой кнопкой мыши на фрейме дан-

ных Layers и выберите Вставить. 

В таблице содержания у вас должна появиться копия слоя городов, иден-

тичная той, на которой вы визуализировали города по принципу «столицы» и 

«не столицы». 

3. Для нижнего из двух слоев городов отключите видимость, а для верх-

него откройте окно свойств слоя. 

4. Выберите способ символизации Quantities, Graduated symbols. 

5. В групбоксе Fields (Поля) установите POPULATION, как поле с данны-

ми для символизации (рис. 4.14).  

6. Установите диапазон размеров символа от 14 до 28, количество классов 

равное 4, а стиль как на рисунке 4.14 (Circle 2, красный цвет).  

7. Нажмите ОК, чтобы применить все настройки для получения итоговой 

модели (рис. 4.15). 

 

 
Рис. 4.14. Параметры способа Quantities, graduated symbols для слоя городов 

 

Задание 8. Для слоя Countries визуализировать данные о численности 

населения стран при помощи способа плотности точек 

1. Откройте окно свойств слоя Countries и установите способ символиза-

ции Quantities, Dot density (Плотность точек) (1на рис. 4.16). 
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Рис. 4.15. Визуализация городов способом градуированных символов (к заданию 7) 

 

 
Рис. 4.16. Параметры построения карты способом плотности точек  

(номера на рисунке соответствуют описанию в тексте) 

 

2. Выделите POP2000 (население за 2000 год). Добавьте поле в перечень 

используемых для визуализации полей (2 на рис. 4.16). 

3. Сделайте двойной щелчок на точке с дефолтным стилем (2 на рис. 4.16) 

чтобы вызвать Symbol Selector. Установите цвет точки – черный, размер – 4. 

4. В поле Dot Value введите значение численности населения, отображае-

мое одной точкой на карте – 500 000 (3 на рис. 4.16). 

5. Задайте бежевый цвет для фоновой заливки полигонов (4 на рис. 4.16). 
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6. Нажмите ОК для получения модели как на рис. 4.17. 

 

 
Рис. 4.17. Результат построения карты способом плотности точек (по заданию 8) 

 

Задание 9. Построить картограмму плотности населения Африки 

1. Откройте окно свойств слоя Countries.   

2. Перейдите на вкладку Symbology (Символизация). 

3. В перечне доступных способов символизации выберите Quantities, 

Graduated color (Количественный, градуированный цвет). 

4. В качестве поля для отображения градуированным цветом выберите 

поле POP2000 (население за 2000 год).  

5. Примените указанный способ визуализации. 

На итоговой карте вы увидите, что страны раскрашены цветами разной 

интенсивности, в зависимости от численности населения. Данная модель пред-

ставляет собой классический способ картограмм. На картограммах же, как вам 

известно, следует использовать не абсолютные показатели, как например чис-

ленность населения, а относительные (нормированные по другому показате-

лю): плотность населения, количество легковых автомобилей на тысячу жите-

лей и т.п. 

Для того чтобы построить карту плотности населения, данные из колонки 

POP2000 нам следует нормировать по колонке KILOMETRS, в которую записа-

ны значения площадей стран в квадратных километрах. Нормировать – значит 

разделить значение одной колонки на значение другой. Различными градация-

ми цвета будет визуализирован результат деления. 

1. Откройте окно свойств слоя Countries. В выпадающем списке 

Normalization (фрейм Fields) смените None на KILOMETERS. 

2. Нажмите Apply для применения нормализации. Вы должны получить 

картосхему как на рисунке 4.18. 
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Рис. 4.18. Картограмма плотности населения стран Африки (фрагмент, разбивка на 

интервалы способом Natural breaks(Jenks)) 

 

На рисунке 4.18 трудно проследить пространственную организацию в 

распределении такого показателя как плотность населения: бОльшая часть Аф-

рики закрашена одним и тем же желтым цветом. Необходимо изменить разбив-

ку на диапазоны для слоя стран. 

3. В окне свойств слоя нажмите кнопку Classify (Классифицировать). 

В появившемся окне Classification (рис. 4.19) видно, что способ разбивки 

на диапазоны, который был применен, – Natural Breaks (Естественные грани-

цы). Обратите внимание также на фрейм Classification Statistics, где есть базо-

вые статистические показатели для плотности населения (медиана, стандартное 

отклонение и другие известные вам по курсу cтатистики). 

 

 
Рис. 4.19. Диалог Classification. Способы разбивки на интервалы 

 

4. Установите способ разбивки на диапазоны Manual (Вручную) и задайте 

границы диапазонов, как это предложено на рисунке 4.20. Примените установ-

ленные параметры. Вы получите картограмму как на рисунке 4.21. 
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Рис. 4.20. Границы интервалов для значений плотности населения 

 

 
Рис. 4.21. Итоговая картограмма по заданию 9 (фрагмент) 

 

Задание 10. Построить картограмму прироста населения (в %) за пе-

риод с 1980 по 2000 год  

Многие, наверное, уже обратили внимание на то, что поля, в котором бы-

ло бы записано значение прироста населения за эти годы, в атрибутивной таб-

лице нет. Зато есть поля с численностью населения стран Африки на 1980 и на 

2000 годы, а прирост в % мы можем рассчитать. 

1. Откройте окно свойств слоя для Countries. 

2. Нормализуйте численность населения на 2000 год по численности на-

селения на 1980 год (рис. 4.22). 

 

 
Рис. 4.22. Нормализация (деление) поля POP2000 по значениям поля  POP1980 

 

3. Нажмите на поле Label (Подпись) и выберите Format Labels (Форма-

тировать подписи) (рис. 4.23). 

4. В появившемся окне форматирования установите процентный формат 

(рис. 4.24). 
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Рис. 4.23. Окно свойств слоя, вкладка Symbology для способа Graduated colors: значения гра-

ниц диапазонов и стиль их представления на карте 

 

 

Рис. 4.24. Окно диалога Number format 

 

5. Примените все настройки для получения карты как на рис. 4.25. 

В странах, которые закрашены темно-коричневым цветом, население за 

20 лет удвоилось (составляет 200 % относительно значения на 1980 год). 

Предположим, вам не интересно, сколько процентов составляет населе-

ние за один год по отношению к другому году. Вас интересует разница числен-
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ности жителей стран за 20 лет в их абсолютном количестве. Для получения это-

го значения необходимо отнять одну переменную от другой, а затем уже при 

необходимости визуализировать. Выполнить указанные действия можно в окне 

таблицы при помощи функциональности Field Calculator. 

 

 
Рис. 4.25. Итоговая карта по заданию 10 

 

1. Нажмите правой кнопкой мыши на слое Countries. 

2. В контекстном меню выберите команду Открыть атрибутивную таб-

лицу. 

3. Нажмите кнопку Options (Опции) → Add Field (Добавить поле). 

4. Установите параметры нового поля pop_growth как на рисунке 4.26. 

 

 
Рис. 4.26. Диалог Add Field: параметры нового поля для расчета  

абсолютного прироста населения (к заданию 10) 



57 
 

5. Нажмите ОК – в таблице появится новое поле pop_growth. Рассчитайте 

в это поле абсолютный прирост населения за 20 лет. 

6. Щелкните правой кнопкой мыши на заголовке поля и выберите в кон-

текстном меню команду  Field Calculator (Калькулятор поля) (рис. 4.27). 

7. В окно Field Calculator в поле pop_growth = введите формулу расчета 

значений прироста населения: [POP2000]-[POP1980] 

В результате Ваша колонка pop_growth заполнится значениями прироста 

населения за 20 лет. Теперь ее можно использовать для визуализации, расчетов 

или анализа. 

 
Рис. 4.27. Вызов команды Field Calculator из контекстного меню  

заголовка поля таблицы атрибутов 

 

Задание 11. Выполнить картографические построения: 

 построить картограмму, отражающую душевое производство электро-

энергии по штатам северо-восточной части территории США; 

 дополнить картограмму круговыми диаграммами, отражающими 

структуру производства электроэнергии; 

 на отдельной карте, по аналогии с п.2, методом круговых диаграмм по-

казать структуру производства электроэнергии для всех субрегионов США;  

 скомпоновать карты, легенду, рамки и названия. 

Для начала подготовьте слои для картографических построений. 

1. Выполните команду меню File → Add Data или нажмите на соответст-

вующую кнопку панели Standard. Перейдите в директорию с данными для 

США и добавьте к карте слои STATES и LAKES. Отобразите слой штатов по-

верх слоя озер. 

2. Откройте окно свойств слоя штатов. 

3. Назначьте слою способ символизации Single Symbol – бежевый цвет. 

4. Кликните на слое правой кнопкой мыши и выберите Копировать. 

5. В таблице содержания кликните на фрейме данных Layers правой кноп-

кой мыши и выберите команду Paste layer(s) (Вставить слои). Вставьте слой 
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два раза. В итоге один и тот же слой штатов будет представлен в окне вашей 

карты трижды. Переименуйте верхний из вставленных слоев штатов на 

States_structure, средний – на States_el_per_capita, нижний – на 

States_background. 

6. Просмотрите таблицу атрибутов для слоя STATES. В атрибутивной таб-

лице присутствуют данные по штатам о процентном соотношении между раз-

ными источниками производства электроэнергии, что записано в соответст-

вующих полях: FOSSIL – ископаемое топливо (газ, нефть, уголь); HYDRO – 

гидроэнергетика; NUCLEAR – атомная; OTHER – прочие источники, в том чис-

ле альтернативные. 

Однако общего производства электроэнергии в кВт-час в колонках таб-

лицы атрибутов нет. Такая информация хранится также во внешней таблице 

Energy.xls. Данные о производстве электроэнергии в ней записаны в тысячах 

MВт-час для каждого штата (за 2010 год). Электронная таблица была заполне-

на данными Министерства энергетики США, с которыми вы можете ознако-

миться, пройдя по ссылкам: http://energy.gov/eere/vehicles/fact-753-november-12-

2012-sources-electricity-state и http://www.eia.gov/electricity/data/state/ . 

 Данные по общему производству электроэнергии можно рассчитать в 

новое поле при помощи инструмента Field Calculator, суммировав значения по 

колонкам FOSSIL, HYDRO, NUCLEAR, OTHER. Другой способ – присоединить 

колонку xls-таблицы к таблице атрибутов слоя STATES. 

1. Добавьте в программу Лист1 из файла Energy.xls, используя функцио-

нальность Add Data. 

2. Откройте Лист1 (правый клик на слое Лист1 в таблице содержания → 

команда Open из контекстного меню), просмотрите его структуру. Лист 

содержит информацию о количестве производимой электроэнергии по штатам 

в поле Electricity. Поля name в электронной таблице EXCEL и STATE_ABBR в 

атрибутивной таблице слоя штатов совпадают – в них одинаковые записи 

сокращенных названий штатов. Эти поля и будут использоваться для 

объединения.  

3. Закройте таблицу Лист1. Откройте атрибутивную таблицу слоя 

States_el_per_capita: среднего по порядку в таблице содержания. Для двух дру-

гих слоев STATES отключите видимость. 

4. В атрибутивной таблице выполните команду Options → Joins and Re-

lates → Join… 

5. В окне Join Data установите параметры, как на рис. 4.28 и нажмите ОК. 

Если все сделано правильно, то обе колонки из xls-таблицы присоединят-

ся к таблице стран. Теперь можно визуализировать новый, добавленный после 

присоединения атрибут Electricity.  

http://energy.gov/eere/vehicles/fact-753-november-12-2012-sources-electricity-state
http://energy.gov/eere/vehicles/fact-753-november-12-2012-sources-electricity-state
http://www.eia.gov/electricity/data/state/


59 
 

 
Рис. 4.28. Диалог Join Data (фрагмент окна): установки  

для присоединения данных из xls-таблицы 

 

1. Откройте окно свойств слоя States_el_per_capita. 

2. Выберите количественный способ символизации, а в нем – градуиро-

ванный цвет. 

3. Установите поле для символизации – Electricity (из присоединенной 

таблицы). 

4. Поле для нормализации – POP2010 (так как мы считаем душевое про-

изводство электроэнергии).  

Теперь в окне свойств слоя мы можем видеть распределение по интерва-

лам значений производства электроэнергии на душу населения. Нормализован-

ные значения меняются в пределах от 0 до 99. И это правильные значения, ведь 

производство электроэнергии в исходной таблице было записано в тысячах 

МВт-час. Отобразим записи в легенде так, чтобы сбросить тысячи и видеть 

значения в мегаваттах.    

5. В окне свойств слоя States_el_per_capita, на вкладке Symbology кликни-

те на поле Label. В контекстном меню выберите Format Labels (рис.4.23). 

6. В окне Number Format перейдите в категорию Rate (1 на рис. 4.29). 

7. В поле  Factor установите вручную значение 0,001 (2 на рис. 4.29). 

8. Нажмите на кнопку Numeric Options (3 на рис. 4.29), чтобы вызвать од-

ноименное диалоговое окно. 

9. В диалоге Numeric Options задайте количество символов после запятой 

равное 2 (4 на рис. 4.29). 

10. Примените все остальные параметры символизации и классификации, 

нажав ОК во всех открытых диалоговых окнах. 

Вы должны получить картограмму (рис. 4.30), которая иллюстрирует ду-

шевое производство электроэнергии в США. 
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Рис. 4.29. Настройки формата отображения подписей числовых данных 

 

 
Рис. 4.30. Картограмма душевого производства электроэнергии по штатам  

 

Теперь необходимо изменить проекцию для отображения слоев, чтобы 

контур США выглядел более естественно. На текущей карте он «растянут» с 

востока на запад. 

1. Нажмите правой кнопкой мыши на фрейме Layers и выберите команду 

Properties. 

2. В окне свойств фрейма перейдите на вкладку Coordinate System (Коор-

динатная система). 

3. Установите проекцию USA Contiguous Albers Equal Area Conic, распо-

ложенную в перечне проекций Predefined → Projected Coordinate Systems  → 

Continental → North America (рис. 4.31).  

Чтобы в дальнейшем не искать конкретную проекцию в дереве каталога, 

вы можете сохранить ее в папку Favorites, нажав на кнопку Add To Favorites. 

4. Нажмите ОК в окне свойств фрейма данных.  

После применения к окну карты указанной проекции, карта США должна 

принять вид как на рис. 4.32. 
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Рис. 4.31. Каталог проекций ArcMap 

 

 
Рис. 4.32 Слой STATES после смены проекции для фрейма данных; диапазоны картограммы 

душевого производства электроэнергии  

 

Смените растяжку цвета с желто-коричневой на пурпурную или зелено-

ватую. 

Теперь отобразим структуру производства электроэнергии. 

1. Включите видимость для самого верхнего из слоев States_structure в 

таблице содержания. Перейдите в режим Full Extent. 

2. Откройте для него окно свойств слоя. 

3. Выберите способ представления данных Charts → Pie. 

4. В поле Fields Selection, удерживая нажатой клавишу Ctrl, выделите 

FOSSIL, NUCLEAR, HYDRO, OTHER и нажмите клавишу «>» (рис. 4.33). 

5. Отредактируйте цвета, кодирующие на будущих круговых диаграммах 

разные способы получения электроэнергии: FOSSIL – красный, HYDRO – си-

ний, NUCLEAR – зеленый, OTHER –  черный (рис. 4.34). Для этого нужно сде-

лать двойной клик на прямоугольнике с цветом, чтобы вызвать окно Symbol 

Selector. Толщину линий везде установите равную 0,5, а их цвет – черный. 
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Рис. 4.33. Выбор полей таблицы атрибутов для отображения их значений  

на круговых диаграммах 

 

 
Рис. 4.34. Стили сегментов круговых диаграмм (цвет заливки, толщина и цвет контура) 

 

6. Нажмите на кнопке Background (Фон) и установите цвет фона Hollow. 

7. Нажмите кнопку Properties и установите параметры отображения кру-

говых диаграмм, включая (отключая) чекбоксы и устанавливая контролы как 

это показано на рисунке 4.35. Затем нажмите ОК. 

8. В окне свойств слоя нажмите на кнопку Size и установите размер диа-

граммы –  24. 

Примените все настройки, чтобы получить предварительную картографи-

ческую модель с круговыми диаграммами (рис. 4.36) 

Диаграммы накладываются друг на друга в восточной части США и вы-

ходят за пределы контуров штатов, что недопустимо. Но и делать их слишком 

маленькими тоже нельзя. В рамках данного задания мы отобразим диаграммы 

только для северо-востока США, в пределах субрегионов Новая Англия («N 

Eng» в таблице атрибутов) и Средняя Атлантика («Mid Atl»). Для остальной 

территории душевое производство и структура электроэнергетики по штатам 

будут скрыты за пределами рамки карты. Вместо них на отдельной карте будет 

показана структура электроэнергетики по источникам энергии для субрегионов 

США. 
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Рис. 4.35. Настройка параметров отображения круговых диаграмм 

 

 
Рис. 4.36. Предварительная картографическая модель структуры и объемов душевого 

производства электроэнергии по штатам США  

 

1. «Зазумьтесь» на северо-восточные штаты США при помощи инстру-

мента  Zoom In. 

2. Перейдите в режим компоновки карты: View → Layout View. 

3. Выполните команду Page and Print Setup из меню Файл. 

4. В появившемся окне Page and Print Setup установите ориентацию листа 

Landscape (Альбомная). Вы должны получить картографическое изображение 

примерно как на рисунке 4.37. 
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Рис. 4.37. Фрагмент карты в режиме простмотра Layout 

 

5. Выделите рамку, в которой находится карта США, и растяните ее так, 

чтобы она занимала примерно половину листа, с небольшими отступами вверху 

и внизу. Далее при помощи увеличителя вам нужно самостоятельно подогнать 

масштаб и расположение картографического изображения внутри рамки так, 

чтобы северо-восточные штаты субрегионов Новая Англия и Средняя Атланти-

ка были вписаны в границы рамки. Ваша карта должна принять вид примерно 

как на рисунке 4.38. 

 
Рис. 4.38. Вид компоновки, северо-восток США во фрейме данных Layers 

 

Как вы можете заметить, на карте присутствуют диаграммы и 

градуированный цвет для неинтерисующих нас территорий других 

субрегионов. Чтобы скрыть их, необходимо выполнить определяющий запрос: 
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1. Перейдите в меню свойств слоя штатов с диаграммами. 

2. Перейдите на вкладку Definition Query (Определяющий запрос). 

3. Нажмите кнопку Query Builder (построитель запросов). В поле для за-

проса введите выражение для представления на карте только штатов интере-

сующих вас субрегионов (рис. 4.39). 

 

 
Рис.4.39. Определяющий запрос для показа северо-восточных штатов слоя 

 

4. Два раза нажмите ОК, подтверждая применение запроса. 

5. Выполните аналогичный определяющий запрос и для слоя 

States_el_per_capita, для которого вы ранее применили градуированный цвет. 

В итоге вы получите карту, на которой градуированный цвет и круговые 

диаграммы будут изображены только для установленных в определяющем за-

просе штатов Новой Англии и Средней Атлантики (рис. 4.40). 

6. В таблице содержания включите видимость самого нижнего из слоев 

STATES. Настройте его визуализацию следующим способом: граница – 0,4, 

Gray 60%; заливка - Gray 10%. 

 

 
Рис. 4.40. Карта производства электроэнергии после применения определяющего запроса 

 

Теперь создадим вторую карту, на которой будет изображена структура 

производства электроэнергии по субрегионам. Слой субрегионов отсутствует в 

наборе данных «usa», поэтому нам придется создать его самостоятельно, 
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объединив все штаты с одинаковой записью по колонке SUBREGION в один 

ГИС-объект. Необходимые атрибутивные характеристики при объединении 

будут суммироваться. 

1. Нажмите на кнопку  Show/ Hide ArcToolbox Window на панели 

инструментов Standard. 

2. В перечне инструментов найдите инструмент Data Management Tools→ 

Generalization → Dissolve (рис. 4.41) и запустите его двойным щелчком. 

 

 
Рис. 4.41. Dissolve в «дереве» инструментов Arctoolbox   

 

3. Откроется окно инструмента Dissolve (рис. 4.42). Установите 

следующие параметры:  

 как входящий слой (выпадающий список Input Features) используйте 

самый нижний из слоев STATES в таблице содержания (без диаграмм и 

градуированного цвета, States_background), а предложенное по умолчанию имя 

итогового слоя (в поле Output Feature Class) измените на Subregion; 

 поле для объединения (Dissolve Field(s)) – SUB_REGION;  

 из выпадающего списка Statistic Field(s) выберите поля, которые 

необходимы нам в будущем слое: FOSSIL, NUCLEAR, HYDRO, OTHER. 

Предупреждение, возникающие после выбора полей, сигнализирует о том, что 

программе неизвестно о способе объединения данных из строк базы данных для 

каждого из штатов, входящих в «свой» субрегион. Как только будет определен 

способ по колонке Statistic Type (в нашем случае – суммирование – SUM), 

сигнализирующие маркеры исчезнут; 

 оставьте чекбокс create multipart features включенным. 

4. Нажмите ОК. В результате в таблице содержания появится новый слой 

Subregion (рис. 4.43), состоящий из девяти полигональных объектов субрегио-

нов, созданных на основе слоя STATES. 
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Рис. 4.42. Окно инструмента Dissolve (настройки соответствуют описанию в тексте) 

 

 
Рис. 4.43. Результат работы инструмента Dissolve для полигонов штатов 
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5. Сделайте слой Subregion невидимым, отключив соответствующий чек-

бокс в таблице содержания.  

Теперь добавим к виду компоновки новый фрейм данных. 

1. Выберите меню Insert (Внести) → Data Frame. Появившийся прямо-

угольник нового фрейма (по умолчанию он называется New Data Frame) пере-

тащите в верхний левый угол карты, а старый фрейм Layers переместите на 

правую половину листа. 

2. Измените проекцию нового фрейма на аналогичную фрейму Layers. 

3. Выделите слой Subregion во фрейме Layers и скопируйте его в новый 

фрейм данных New Data Frame дважды. Верхний из скопированных слоев пе-

реименуйте на Subregion_structure, а нижний – на Subregion_areas. После этого 

можно удалить слой Subregion из старого фрейма Layers. 

На данном этапе вы получаете карту как на рисунке 4.44. 

 

 
Рис. 4.44. Два фрейма данных в окне ArcMap 

 

Теперь необходимо построить круговые диаграммы структуры электро-

энергетики для субрегионов США.  

1. Откройте окно свойств слоя для Subregion_structure. 

2. Перейдите на вкладку Symbology и выберите способ Pie (Круговые диа-

граммы), чтобы построить круговые диаграммы на основании обобщенных ви-

зардом Dissolve данных по производству электроэнергии. 

3. Примените параметры построения круговых диаграмм идентичные па-

раметрам для штатов северо-востока во фрейме Layers. 

4.  Откройте окно свойств слоя Subregion_areas, перейдите на вкладку 

Symbology и выберите способ визуализации слоя – Категории. В поле Value 

Field установите колонку SUB_REGION и нажмите кнопку Add Values.  

5. В появившемся окне Add Values (рис. 4.45) выделите субрегионы      
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Mid Atl и N Eng, а затем нажмите ОК.  

6. В окне свойств слоя для выбранных на предыдущем шаге субрегионов 

установите цвет Solar Yellow. Для остальных субрегионов, в окне свойств слоя 

помеченных как <all other values>, установите цвет Sahara Sand (рис. 4.46). Та-

ким образом, вы выделите цветом территории субрегионов, которые показаны 

на более детальной карте справа. 

7. Нажмите ОК в окне свойств, чтобы получить карту как на рис. 4.47. 

 

 
Рис. 4.45. Окно добавления данных при визуализации способом категорий 

 

 
Рис. 4.46. Стили субрегионов при их визуализации способом категорий 

 

 
Рис.4.47. Карта после добавления диаграмм к слою субрегионов 
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Теперь можно подписать названия штатов и субрегионов, а также вы-

брать оптимальное расположение для диаграмм, конвертировав их в графиче-

ские объекты. 

1. Откройте окно свойств слоя States_structure и перейдите на вкладку 

Labels (Подписи). 

2. Установите следующие параметры подписей: 16 шрифт, arial, курсив. 

Нажмите ОК в окне свойств слоя. 

3. В контекстном меню для слоя States_structure выберите команду  Label 

Features (Подписать объекты).  

Объекты слоя будут подписаны. Но для того чтобы разместить подписи 

наиболее правильно, чтобы они не накладывались друг на друга и на диаграм-

мы, располагались вдоль ГИС-объектов штатов, необходимо конвертировать их 

в аннотации.  

Возможно, для наиболее правильного размещения объектов на карте при-

дется изменить и положение диаграмм. Для того, чтобы было можно переме-

щать диаграммы в пределах карты, их необходимо конвертировать в графиче-

ские объекты. 

4. Конвертируйте надписи стран в аннотации. Нажмите правой кнопкой 

мыши на слое State_structure в основном фрейме Layers и выберите команду 

Convert Labels To Annotations (Конвертировать подписи в аннотации). В окне 

конвертации установите параметры In the map (На карте), All features (Все объ-

екты) и нажмите ОК.  

5. Кликните правой кнопкой мыши на слое State_structure в основном 

фрейме Layers и выберите Convert Features To Graphics (Конвертировать ГИС-

объекты в графику). Конвертируйте все объекты слоя. Для этого включите оп-

цию All  в диалоге конвертации. 

Теперь вы можете редактировать ваши подписи по отдельности: переме-

щать их в пределах карты, менять ориентацию, менять шрифты и т.п. То же са-

мое касается и диаграмм.  

6.  Отредактируйте положение подписей так, чтобы они, по возможности, 

не перекрывали другие объекты и надписи. Для этого выберите курсором нуж-

ную подпись и начинайте редактировать. Удерживая нажатой левую кнопку 

мыши подпись можно переместить на требуемое место. Подписи можно также 

поворачивать инструментом  Rotate (Повернуть), расположенным на панели 

инструментов Draw. Двойной щелчок на подписи вызывает окно свойств (рис. 

4.48), в котором можно изменить шрифт, например, сделать его разреженным в 

поле Character Spacing, чтобы подпись полностью заполняла штат. Для того 

чтобы поменять сам шрифт, нужно вызвать окно Symbol Selector, нажав на 

кнопку Change Symbol в окне свойств текста. 
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Рис. 4.48. Окно свойств выбранной аннотации 

 

7. Диаграммы переместите так, чтобы в пределах штата они заняли наи-

лучшее на ваш взгляд расположение.  

Инструментом New Line (Новая линия, расположен на панели Draw) мож-

но также рисовать линии-выноски (рис. 4.49), показывающие ГИС-объект, к ко-

торому относится аннотация. 

 
Рис. 4.49. Образец выноски для текстового элемента карты 

 

Для некоторых штатов подписи придется удалить, оставив на их месте 

цифры, чтобы затем внизу карты расшифровать, какие штаты этими цифрами 

обозначены. 

Образец карты с подписями показан на рисунке 4.50.  

Самостоятельно подпишите, а затем создайте аннотации для слоя субре-

гионов на карте слева. 

Осталось добавить легенду, название карты и масштабную линейку. 
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Рис. 4.50. Образец  размещения аннотаций для фрейма данных Layers 

 

1. Выбрав команду меню Insert → Title (Внести → Название), отредакти-

руйте расположение и содержание названий,  как это показано на рисунке 4.51. 

 

 
Рис. 4.51.  Оформление заголовков карты 

 

2. Выделите фрейм с северо-восточными штатами и выберите меню Insert 

→ Legend (Внести → Легенду). 

3. В окне Legend Wizard, на первой странице визарда (рис. 4.52) удалите 

из контента легенды все слои кроме States_structure и States_el_per_capita. 

4. В поле Set the Number of Columns in your Legend установите 2. 

5. Нажмите Next. 

6. В поле Legend Title введите «S Y M B O L S». 

7. Остальные параметры примите по умолчанию, нажимая на кнопки Да-

лее и Готово. 

8. Переместите появившуюся легенду в нижний левый угол карты. 

9. Щелкните правой кнопкой мыши на легенде и выберите команду кон-
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текстного меню Convert To Graphics. 

10. Щелкните правой кнопкой мыши на легенде и выберите Ungroup. 

Теперь вы можете перемещать на вашей карте не всю легенду сразу, а 

каждый отдельный ее элемент. Также вы можете редактировать подписи в ле-

генде, вызывая окно свойств для текстовых элементов карты. 

11. Приведите легенду к виду как в образце на рисунке 4.53. 

 

 
Рис. 4.52. Первый шаг инструмента Legend Wizard (фрагмент) 

 

 
Рис. 4.53. Образец оформления легенды карты 

 

Осталось добавить масштабную линейку. 

1. Выделите фрейм карты субрегионов. 

2. Выберите команду меню Insert → Scale Bar (Внести –> Масштабную 

линейку). 

3. В окне Scale Bar Selector выберите тип линейки Scale Line 1 и нажмите 

ОК. 

4. Переместите масштабную линейку в нижнюю часть карты субрегионов 

и сделайте на ней двойной щелчок. 

5. В открывшемся диалоге Scale Line Properties (Свойства масштабной 

линейки) перейдите на вкладку Scale and Units и установите следующие пара-
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метры: 

 Number of divisions и Number of subdivisions – по 2; 

 В боксе Units задайте параметры Label и Division Units – километры, 

положение подписи – after labels, Gap – 1 pt; 

 Чекбокс Show one division before zero оставьте выключенным; 

 В выпадающем списке When resizing установите Adjust division value. 

В итоге вы получили итоговую карту. Можно выполнить ее экспорт в 

файл рисунка. 

1. Выберите команду меню File → Export Map. 

2. На вкладке General окна Export Map выберите разрешение 200 dpi. В 

выпадающем списке тип файла установите *.PNG. 

3. Сохраните рисунок под именем usa_electricity.png 

Итоговая карта должна выглядеть как на рисунке 4.54. 

 

 
Рис. 4.54. Итоговая карта электроэнергетического сектора США (по заданию 11) 

 

 

Контрольное задание 

Самостоятельно постройте картографическую модель как на рисунке 

4.55. 
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Рис. 4.55. Образец карты для выполнения самостоятельного контрольного задания 

 

Слои для карты 

LAKES, Rivers, STATE, COUNTIES 

Символизация атрибутов 

1. Основная карта 

Структура населения «женатые/ разведенные», способ – картодиаграмма 

(слой State, колонки: MARRIED, DIVORSED). 

2. Врезка 1 

Процент афроамериканского населения, способ – градуированный цвет 

(слой COUNTIES; колонка BLACK, нормализованная по POP2010; стиль объек-

тов полигонов – бесцветный контур; формат чисел для легенды – процентный с 

одним знаком после запятой). 

Слой STATE  – пустой (Hollow). 

3. Врезка 2 

Процент населения испанского происхождения, способ – градуированный 

цвет (слой COUNTIES; колонка HISPANIC, нормализованная по POP2010; 

стиль объектов полигонов – бесцветный контур; формат чисел для легенды – 

процентный с одним знаком после запятой). 

Слой STATE – пустой (Hollow). 

Подписи  

Подписи по атрибутам слоя STATE (поле STATE NAME, подписи переве-

дены в аннотации). 
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Контрольные вопросы: 

1. Какие основные составляющие стиля отображения элементарных век-

торных ГИС-объектов вы знаете? 

2. В чем заключается тематическое картографирование в ГИС? 

3. Какие способы визуализации атрибутивных данных в ArcGIS вам из-

вестны? 

4. В чем состоит способ визуализации «категории»? Для каких данных 

уместен данный способ визуализации атрибутов? Какие особенности способа 

Categories - Unique values, many fields?  

5. В чем заключается способ визуализации «количество»? Для каких дан-

ных и векторных объектов можно использовать данный способ визуализации 

атрибутов? 

6. Что такое «нормализация» в контексте построения тематических карт в 

программе ArcGIS? Для чего она применяется? 

7. Чем отличаются обычные подписи от аннотаций? Какие основные па-

раметры задает пользователь при создании аннотаций? 

8. Опишите особенности функциональности Dissolve. 

9. Какие элементы оформления карты доступны пользователю из меню 

Insert? 

10. Что такое «вид данных» и «вид компоновки»? Чем они отличаются? 

Как создать карту-врезку в ArcGIS? 

11. Для чего предназначен инструмент Join? 

12. Опишите особенности функциональности Legend Wizard? 

13. Как изменить проекцию отображения слоев во фрейме данных? 
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